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Preface

Audience for This Guide
Welcome to Release 11i of the Oracle® Release Management User’s Guide.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle® Release Management

If you have never used Oracle® Release Management, we suggest you attend 
one or more of the Oracle® Release Management training classes available 
through Oracle University. 

■ The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User Guide.

See Other Information Sources for more information about Oracle Applications 
product information.
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How To Use This Guide
This guide contains the information you need to understand and use Oracle® 
Release Management.

This preface explains how this user guide is organized and introduces other sources 
of information that can help you. This guide contains the following chapters:

■ Chapter 1 gives you an overview of Release Management.

■ Chapter 2 explains the Release Management Processing Rules.

■ Chapter 3 describes how to define and use your own Shipment Delivery Pattern 
Rules in Release Management.

■ Chapter 4 describes the Release Management Workbench and explains how to 
navigate the windows to manage incoming demand.

■ Chapter 5 explains the use of Cumulative Accounting in Release Management 
and describes the CUM Workbench where you can manage your Cumulative 
Accounting rules.

■ Chapter 6 provides an explanation of Release Management reports and 
processes.

■ The appendices provide you with complete navigation paths to all windows in 
Release Management as well as information on the available profile options.

Finding Out What’s New
From the HTML help window for Oracle® Release Management, choose the section 
that describes new features or what’s new from the expandable menu. This section 
describes:

■ New features in 11i. This information is updated for each new release of 
Oracle® Release Management.

■ Information about any features that were not yet available when this user guide 
was printed. For example, if your system administrator has installed software 
from a mini pack as an upgrade, this document describes the new features.

Note: Implementation information and procedures are included 
in the Oracle® Release Management Implementation Manual.
xiv



Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle® Release Management. 

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides unless otherwise specified.

Online Documentation
All Oracle Applications documentation is available online in HTML and PDF 
formats. The technical reference guides are available in paper format only. Note that 
the HTML documentation is translated into over twenty languages.

The HTML version of this guide is optimized for onscreen reading, and you can use 
it to follow hypertext links for easy access to other HTML guides in the library. 
When you have an HTML window open, you can use the features on the left side of 
the window to navigate freely throughout all Oracle Applications documentation.

■ You can use the Search feature to search by words or phrases.

■ You can use the expandable menu to search for topics in the menu structure we 
provide. The Library option on the menu expands to show all Oracle 
Applications HTML documentation.

You can view HTML help in the following ways:

■ From an application window, use the help icon or the help menu to open a new 
Web browser and display help about that window.

■ Use the documentation CD.

■ Use a URL provided by your system administrator.

Your HTML help may contain information that was not available when this guide 
was printed.
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Related User Guides
Oracle® Release Management shares business and setup information with other 
Oracle Applications products. Therefore, you may want to refer to other user guides 
when you set up and use Oracle® Release Management.

You can read the guides online by choosing Library from the expandable menu on 
your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle store at 
http://oraclestore.oracle.com.

User Guides Related to All Products

Oracle Applications User Guide
This guide explains how to navigate the system, enter data, and query information, 
and introduces other basic features of the GUI available with this release of Oracle® 
Release Management (and any other Oracle Applications product). 

You can also access this user guide online by choosing Getting Started and Using 
Oracle Applications from the Oracle Applications help system.

Oracle Alert User Guide
Use this guide to define periodic and event alerts that monitor the status of your 
Oracle Applications data.

Oracle Applications Implementation Wizard User Guide
If you are implementing more than one Oracle product, you can use the Oracle 
Applications Implementation Wizard to coordinate your setup activities. This guide 
describes how to use the wizard.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards. It also provides information to help you build 
your custom Oracle Developer forms so that they integrate with Oracle 
Applications.
xvi



Oracle Applications User Interface Standards
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

User Guides Related to This Product

Oracle Applications Demonstration User’s Guide
This guide documents the functional storyline and product flows for Vision 
Enterprises, a fictional manufacturer of personal computers products and services. 
As well as including product overviews, the book contains detailed discussions and 
examples across each of the major product flows. Tables, illustrations, and charts 
summarize key flows and data elements. 

Oracle Bills of Material User’s Guide
This guide describes how to create various bills of materials to maximize efficiency, 
improve quality and lower cost for the most sophisticated manufacturing 
environments. By detailing integrated product structures and processes, flexible 
product and process definition, and configuration management, this guide enables 
you to manage product details within and across multiple manufacturing sites.

Oracle e-Commerce Gateway User’s Guide
This guide describes how Oracle e-Commerce Gateway provides a means to 
conduct business with trading partners via Electronic Data Interchange (EDI). Data 
files are exchanged in a standard format to minimize manual effort, speed data 
processing and ensure accuracy.

Oracle Inventory User’s Guide
This guide describes how to define items and item information, perform receiving 
and inventory transactions, maintain cost control, plan items, perform cycle 
counting and physical inventories, and set up Oracle Inventory.
xvii



Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide
This guide describes how to anticipate and manage both supply and demand for 
your items. Using a variety of tools and techniques, you can create forecasts, load 
these forecasts into master production schedules, and plan your end-items and their 
component requirements. You can also execute the plan, releasing and rescheduling 
planning suggestions for discrete jobs and repetitive schedules.

Oracle Order Management User’s Guide
This guide describes how to enter sales orders and returns, copy existing sales 
orders, schedule orders, release orders, plan departures and deliveries, confirm 
shipments, create price lists and discounts for orders, and create reports. should be 
This guide describes how to enter sales orders and returns, copy existing sales 
orders, schedule orders, release orders, create price lists and discounts for orders, 
run processes, and create reports. 

Oracle Receivables User’s Guide
Use this manual to learn how to implement flexible address formats for different 
countries. You can use flexible address formats in the suppliers, banks, invoices, and 
payments windows.

Oracle Work in Process User’s Guide
This guide describes how Oracle Work in Process provides a complete production 
management system. Specifically this guide describes how discrete, repetitive, 
assemble-to-order, project, flow, and mixed manufacturing environments are 
supported.

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes. You also 
use this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.
xviii



Reference Manuals

Oracle Technical Reference Manuals
Each technical reference manual contains database diagrams and a detailed 
description of database tables, forms, reports, and programs for a specific Oracle 
Applications product. This information helps you convert data from your existing 
applications, integrate Oracle Applications data with non-Oracle applications, and 
write custom reports for Oracle Applications products.

You can order a technical reference manual for any Oracle Applications product you 
have licensed.

Oracle Release Management Implementation Manual
This manual describes the setup and implementation of the Oracle Applications 
used for the Oracle Automotive solution, including Oracle Release Management 
and Oracle Automotive.

Oracle Manufacturing and Distribution Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes open interfaces found in Oracle Manufacturing.

Oracle Applications Message Reference Manual
This manual describes all Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Oracle Project Manufacturing Implementation Manual
This manual describes the setup steps and implementation for Oracle Project 
Manufacturing.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup, and reference information for the 
Oracle® HRMS implementation team, as well as for users responsible for the 
ongoing maintenance of Oracle Applications product data. This guide also provides 
information on creating custom reports on flexfields data.
xix



Installation and System Administration Guides

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind, and major issues, for Applications-wide 
features such as Business Intelligence (BIS), languages and character sets, and 
self-service applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle One-Hour Install, which minimizes the time it takes to install Oracle 
Applications and the Oracle 8i Server technology stack by automating many of the 
required steps. This guide contains instructions for using Oracle One-Hour Install 
and lists the tasks you need to perform to finish your installation. You should use 
this guide in conjunction with individual product user guides and implementation 
guides.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process in 
general and lists database upgrade and product-specific upgrade tasks. You must be 
at either Release 10.7 (NCA, SmartClient, or character mode) or Release 11.0 to 
upgrade to Release 11i. You cannot upgrade to Release 11i directly from releases 
prior to 10.7.

Using the AD Utilities
Use this guide to help you run the various AD utilities, such as AutoInstall, 
AutoPatch, AD Administration, AD Controller, Relink, and others. It contains 
how-to steps, screenshots, and other information that you need to run the AD 
utilities.
xx



Oracle Applications Product Update Notes
Use this guide as a reference if you are responsible for upgrading an installation of 
Oracle Applications. It provides a history of the changes to individual Oracle 
Applications products between Release 11.0 and Release 11i. It includes new 
features and enhancements and changes made to database objects, profile options, 
and seed data for this interval.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage processing.

Oracle Self-Service Purchasing Implementation Manual
This manual describes how to set up Oracle Self-Service Purchasing. Self-Service 
Purchasing enables employees to requisition items through a self-service, Web 
interface.

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes. You also 
use this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.
xxi



Training and Support

Training
We offer a complete set of training courses to help you and your staff master Oracle 
Applications. We can help you develop a training plan that provides thorough 
training for both your project team and your end users. We will work with you to 
organize courses appropriate to your job or area of responsibility. 

Training professionals can show you how to plan your training throughout the 
implementation process so that the right amount of information is delivered to key 
people when they need it the most. You can attend courses at any one of our many 
Educational Centers, or you can arrange for our trainers to teach at your facility. We 
also offer Net classes, where training is delivered over the Internet, and many 
multimedia-based courses on CD. In addition, we can tailor standard courses or 
develop custom courses to meet your needs.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle® HRMS working for 
you. This team includes your Technical Representative, Account Manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
business area, managing an Oracle server, and your hardware and software 
environment.
xxii



Do Not Use Database Tools to Modify Oracle Applications Data
We STRONGLY RECOMMEND that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications tables, 
unless we tell you to do so in our guides.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an 
Oracle Applications form can update many tables at once. But when you modify 
Oracle Applications data using anything other than Oracle Applications forms, you 
might change a row in one table without making corresponding changes in related 
tables. If your tables get out of synchronization with each other, you risk retrieving 
erroneous information and you risk unpredictable results throughout Oracle 
Applications.

When you use Oracle Applications forms to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. But, if you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support and office 
automation, as well as Oracle Applications. Oracle Applications provides the 
E-business Suite, a fully integrated suite of more than 70 software modules for 
financial management, Internet procurement, business intelligence, supply chain 
management, manufacturing, project systems, human resources and sales and 
service management.  

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers, and personal digital assistants, enabling organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.
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Oracle is the world’s leading supplier of software for information  management, 
and the world’s second largest software company. Oracle offers its database, tools, 
and application products, along with related consulting, education and support 
services, in over 145 countries around the world.

Your Feedback
Thank you for using Oracle® HRMS and this user guide.

We value your comments and feedback. This guide contains a Reader’s Comment 
Form you can use to explain what you like or dislike about Oracle® HRMS or this 
user guide. Mail your comments to the following address or call us directly at (650) 
506-7000.

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Or, send electronic mail to appsdoc@us.oracle.com.
xxiv
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1

Release Management

Introduction and Overview
This manual is intended as an overview of Oracle Release Management. Oracle 
Release Management automates high volume electronic demand management by 
continually incorporating your customers’ demand into your order and planning 
processes. Release Management validates, archives, manages and reconciles 
customers’ planning, shipping and production sequence schedules with timely 
updates to sales orders and forecasts.

By defining and applying hierarchical processing rules, you can easily determine 
correct quantities, dates, and other valuable information required to ensure on-time 
delivery of goods to your customer. You can electronically collaborate with your 
customers and manage demand more accurately. Oracle Release Management 
provides a centralized view of current order status.

See Also
Release Management Processing Rules

Shipment Delivery Rules

Release Management Workbench

CUM Workbench

Reports and Processes

Profile Options
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Release Management Processing Rules

This chapter provides you with the information you need to set up Release 
Management Processing Rules:

■ Overview of Processing Rules on page 2-2

■ Processing Rules on page 2-5

■ Release Management Processing Rules on page 2-10

■ Matching Attributes on page 2-23
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Overview of Processing Rules
When managing customer demand it is imperative to consider internal and external 
business rules which dictate how demand is processed into the order management 
and production fulfillment cycle. The Release Management Processing Rules form 
provides a single location for defining and maintaining business rules applied to 
inbound schedules lines for calculation of the optimum shipment date, quantity and 
sourcing information. The Release Management Processing Rules are maintained 
for three levels of customer and business relationships information: 

■ Ship-From/Customer Rules

■ Ship-From/Ship-To Rules

■ Ship-From/Customer Item Rules

Processing Rules are defined in terms of specific ship-from organizations. When all 
Rules are consistent for customer addresses and customer items, only the 
Ship-From/Customer Rules needs to be defined. To override Rules from the 
customer level, you can enter address information at the Ship-From/Ship-To Rules 
level. Further, if you want to associate a customer item to a specific address or 
customer, you can define processing rules at the Ship-From/Customer Item level. 
For example, this may be useful for cases in which you want to disable CUM 
calculation for a specific item for which the address or customer has CUM 
Management enabled.

The Demand Processor obeys the following hierarchy when using the processing 
rules:

1. Ship-From/Address/Customer Item Rules

2. Ship-From/Customer Item Rules

3. Ship-From/Address Rules

4. Ship-From/Customer Rules

The Release Management Processing Rules form is composed of two windows: a 
find window for entering search parameters and a summary window for entering 
data and viewing key customer information.
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Prerequisites
In order to define ship-from customer item information, you must perform the 
following steps:

■ Define Customer Addresses. See: Oracle Accounts Receivables.

■ Define Warehouse/Inventory Organization. See: Oracle Inventory.

■ Define Inventory Items. See: Oracle Inventory.

■ Define Customer Item. See: Oracle Inventory.

■ Define Pricing Agreements. See: Oracle Order Management.

■ Define Price List for the preferred inventory item if you do not want to use a 
pricing agreement on this item. See: Oracle Order Management.

■ Define Sales Order Header. See: Oracle Order Management.

■ Define Customer Receiving Calendar. See: Oracle Shipping Execution.

■ Define Warehouse Shipping Calendar. See: Oracle Shipping Execution.
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Establish Release Management Processing Rules
■ Determine which method of CUM Management will be used.

In Oracle Release Management, add any additional information to the customer 
address that will be used to define the addresses associated with your customer. 
This information is entered by warehouse or inventory organization, so for 
every warehouse that does business with this customer address, you have 
defined CUM Org Level Setup, CUM Rule, etc.

■ Determine your Intransit time.

The value of the Intransit Time will be used to determine the shipment date 
between a particular warehouse and a customer address.

■ Determine the sales order number.

Demand will be loaded to the sales order number defined at the lowest level for 
this ship-from/ship-to relationship.

■ Define any new shipment delivery pattern codes and override transmitted 
customer codes, as desired.

Oracle Release Management allows you to override the ship delivery pattern 
code transmitted on inbound demand transactions by your customer and use a 
code of your own choosing.

Using the Ship Delivery Pattern Rules form, create any desired custom pattern 
codes. Once established, you can use these codes as a default at the customer 
address level on this form by setting the default ship delivery pattern code to 
the desired value. Be sure to indicate any overrides on the demand 
management tab of the Release Management Processing Rules Details window.

See Also
Processing Rules

Matching Attributes

Overview of CUM Workbench

Overview of Shipment Delivery Rules

Release Management Demand Processor
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Processing Rules
The summary window displays those relationships for which you have defined 
processing rules. This window allows you to view these processing rules or, if you 
have sufficient security access, enter and modify processing rules on your own.

The processing rules window is composed of three regions. The Ship-From 
Organization region in the top leftmost portion of the window includes the 
customer name and code of the ship-from organization. These fields will be 
completed upon query or, if you have sufficient security access to enter or modify 
processing rules, you can manually make changes.

The Ship-To Customer region in the top rightmost portion of the window includes 
fields that display the customer name and number. If you are entering or modifying 
processing rules, both of these fields are accessible. There are also two buttons in 
this region: Matching Logic and Customer Rules.
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Tabbed Regions

■ Ship-To Addresses--the top half displays the EDI location codes, cities and 
addresses for the corresponding customer selected above.

The lower half of the Ship-To Addresses tab includes information more directly 
related to items at the address level: customer item, description and commodity 
code.

■ Customer Items--displays customer item, description and commodity code for 
the corresponding customer selected above.
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Buttons
■ Matching Logic--opens the Matching Attributes window for the current record.

■ Customer Rules--opens the Release Management Processing Rules Details 
window defaulted at the customer level.

■ Address Rules--opens the Processing Rules Details window defaulted at the 
address level.

■ Item Rules (Ship-To Addresses tab)--opens the Processing Rules Details 
window defaulted at the address item level.

■ Item Rules (Customer Items tab)--opens the Processing Rules Details window 
defaulted at the customer item level.
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Find Processing Rules

This window allows you to query the processing rules using specific selection 
criteria. If you have sufficient security access to enter processing rules directly, you 
can bypass this window without entering a query.

Query the processing rules using a range of criteria:

■ Ship From Org - To limit the query to processing rules for a single organization, 
enter the organization code which represents the supplier’s ship-from location.
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■ Customer Name/Number - Enter the customer name or number to limit the 
query to processing rules for a single customer. If you do not specify a 
customer, all processing rules matching your other selection criteria will display 
in the summary window.

■ Ship-To Location - Enter the customer shipping address code to limit the query 
to processing rules for a single customer shipping address. If you do not enter a 
ship-to location code, demand for all shipping addresses associated with the 
specified selection criteria will display in the summary window.

■ Customer Item Number - Enter the customer item to limit the query to 
processing rules for a single customer item. If you do not enter a specific 
customer item, all processing rules matching your other selection criteria will 
display in the summary window.

See Also
Matching Attributes

Release Management Processing Rules
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Release Management Processing Rules
The Release Management Processing Rules Details window can be accessed in a 
number of different ways, each defaulting to the most appropriate record to 
facilitate data entry. This window allows you to view details of the processing rules 
for the current row in the summary window. Several tabs give access to various 
categories of these rules. If you have sufficient security access, you can also enter 
and modify processing rules in this window.

The top half of the Release Management Processing Rules Details window is 
composed of fields that correspond to the Rules level. As a result, some of these 
fields may not be present at all times.

You can view information in the following fields: Customer Name, Number, Ship-to 
Location, City, Address, Customer Item, Commodity Code.
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Tabbed Regions

■ Demand Management--displays the following information: consume demand 
hierarchy, ATS PreHorizon disposition/cutoff days, use customer’s ship 
delivery pattern, default ship delivery pattern, round to standard pack, 
standard pack quantity and demand Tolerances (positive/negative).
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■ Demand Fences--displays the frozen, firm and forecast fences to Oracle 
Planning and forecast fence to Oracle Order Management for planning, 
shipping and sequenced schedules.
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■ Order Management--displays the following information: sales order, purchase 
order, current and future pricing agreements (with effective dates), price list, 
in-transit time and UOM.
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■ CUM Management--displays the CUM management type, CUM org level, 
shipment rule code and yesterday time cutoff information. For cases in which 
you have defined Processing Rules at the Item Level, an additional flag is 
available for disabling CUM Management for the current item.
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■ General--displays the customer contact, supplier contact, assigned supplier 
code, inactive date and any notes related to the current row in the summary 
window.
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Consume Demand Hierarchy
Consume Demand Hierarchy logic controls the reconciliation of demand from 
lower ranking schedules with demand from a new higher ranking schedule using 
Match Across Attributes. 

Three types of inbound demand schedules are recognized by the Demand 
Processor:  Planning, Shipping, and Sequenced.  When demand from more than one 
of these schedule types exists on the Sales Order, demand from lower ranking 
schedules is overlaid or consumed by demand on a new higher ranking schedule, 
based on the applicable value of the Consume Demand Hierarchy Code in context 
of the new scheduleís horizon start and end dates.

Consume Demand Hierarchy logic is used only when the new scheduleís Purpose 
Code is Replace or Change; other purpose codes are excluded.  Whether the 
demand is overlaid or consumed depends on the existing demand scheduled ship 
date and bucket type in context of the scheduleís horizon:

■ Existing demand is overlaid (replaced) if its scheduled ship date and period of 
time represented by its corresponding bucket type falls completely within the 
scheduleís horizon 

■ Existing demand is consumed if its scheduled ship date with bucket type 
includes a period of time after the scheduleís horizon end date 

Consume Demand Hierarchy Code is defined in Release Management Processing 
Rules at the Ship From/Customer or the Ship From/Address levels. You may 
assign the value that reflects the trading partnerís business practices as to how the 
inbound demand schedules relate to one another for demand consumption.  The 
following list indicates the six choices for Consume Demand Hierarchy Code with 
their corresponding demand consumption rules:

Planning, Shipping, Sequenced (Default)
■ Planning Schedule does not overlay other schedules

■ Shipping Schedule overlays Planning but not Sequenced

■ Sequenced Schedule overlays Shipping and Planning 

Planning, Sequenced, Shipping
■ Planning Schedule does not overlay other schedules

■ Sequenced Schedule overlays Planning but not Shipping

■ Shipping Schedule overlays Sequenced and Planning 
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Shipping, Planning, Sequenced
■ Shipping Schedule does not overlay other schedules

■ Planning Schedule overlays Shipping but not Sequenced

■ Sequenced Schedule overlays Shipping and Planning 

Shipping, Sequenced, Planning
■ Shipping Schedule does not overlay other schedules

■ Sequenced Schedule overlays Shipping but not Planning 

■ Planning Schedule overlays Shipping and Sequenced

Sequenced, Planning, Shipping
■ Sequenced Schedule does not overlay other schedules

■ Planning Schedule overlays Sequenced but not Shipping

■ Shipping Schedule overlays Planning and Sequenced

Sequenced, Shipping, Planning
■ Sequenced Schedule does not overlay other schedules

■ Shipping Schedule overlays Sequenced but not Planning

■ Planning Schedule overlays Sequenced and Shipping

Consume Demand Hierarchy Example
For example, suppose we have recently received six replacement schedules from 
our trading partner, and each one includes a daily bucket with a demand 
requirement for today. This trading partner setup has the default Consume Demand 
Hierarchy Code of "Planning, Shipping, Sequenced".  

Because the different schedules have the same date and bucket type for today, there 
will only be one sales order line to reflect todayís demand, and the quantity and 
schedule type will change to reflect the most recent schedule which updated it.  
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The following chart illustrates the results of Consume Demand Hierarchy logic for 
today’s demand line:

Notice that the second shipping and planning schedules did not update the sales 
order line, because they have a lower hierarchy than the sequenced schedule.

ATS Pre-Horizon Disposition Rule Application
If unshipped firm demand exists on the sales order dated before the schedule 
horizon start date, it is managed according to the value of ATS Pre-Horizon 
Disposition Code.

Oracle Release Management allows you to control how the Demand Processor 
handles unshipped firm (ATS) sales order demand dated before the schedule 
horizon. For each Ship-From/Customer or Ship-From/Address relationship you 
can select the appropriate value for ATS Pre-Horizon Disposition Code by selecting 
from the following options: Remain on File, Cancel after N Days, and Cancel All.

The value you select depends on how your customer’s new demand schedules 
reflect past due demand. Some customers change the date of the past due demand, 
some leave it as it was originally sent, some cancel it and increase their 
requirements for dates within the new schedule horizon.

Schedule Sales Order Line

Reference Ship Date Quantity
Scheduled 
Ship Date

Demand 
Quantity Schedule Type

Planning #1 Today 1 Today 1 Planning

Shipping #1 Today 2 Today 2 Shipping

Sequenced #1 Today 3 Today 3 Sequenced

Shipping #2 Today 4 Today 3 Sequenced

Planning #2 Today 5 Today 3 Sequenced

Sequences #2 Today 6 Today 6 Sequenced
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Tolerance Changes
When you define a customer item in the Customer Item form within Oracle 
Inventory, you can identify values for positive and negative demand tolerances.

You may also define positive and negative demand tolerances specific to the 
Ship-From/Customer or Ship-From/Address relationship in Oracle Release 
Management Processing Rules.

When the Demand Processor’s Reconcile Old and New Demand procedure finds a 
match with an existing demand record and attempts to make a change to quantity, a 
calculation is made to verify that the change quantity doesnít violate the lowest 
applicable level of tolerances. If the calculation determines that the quantity change 
does exceeds a tolerance, Oracle Release Management processes the change but 
raises a warning on the exceptions report.  

Demand Fences
To better control how demand is managed on your schedules, you can specify 
ranges of days from the demand schedule’s horizon start date within which you 
want to override the customer-specified status of demand which has been 
processed through the e-Commerce Gateway. However, manually entered 
schedules are not affected by Frozen, Firm, and Forecast Fences.

■ Frozen - A Frozen Fence prevents new demand in the Demand Processor from 
changing the existing Sales Order demand. New demand is not updated to the 
Sales Order and a warning is issued if frozen demand has been changed on the 
schedule.

■ Firm - A Firm Fence overrides the customer demand status by updating to the 
Sales Order as Firm (i.e. shippable), regardless of the customer-specified status 
on the schedule.

■ Forecast (Order Management) - A Forecast Fence to Order Management 
overrides the customer demand status by updating to the sales order as 
Forecast (not authorized to ship), regardless of the customer-specified status on 
the schedule. When either forecast fence is specified, requirements dated later 
are dropped. When a forecast fence is not specified but a firm fence is, 
requirements dated later than the firm fence are updated to the Sales Order 
based on the customer-specified status.
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■ Forecast (Planning) - A Forecast Fence to Planning overrides the customer 
demand status by updating to Oracle Planning as Forecast, regardless of the 
customer-specified status on the schedule. When either of these forecast fences 
is specified, requirements dated later are dropped. When a forecast fence is not 
specified but a firm fence is, requirements dated later than the firm fence are 
updated to the Sales Order based on the customer-specified status.

Each type of demand schedule has its own set of frozen, firm, and forecast fences.   
You can tailor demand fence processing to supplier relationships at any of the three 
Rules levels: customer, address, or customer item.

The following rules apply when entering From and To Fence Days for a specific 
schedule type:

■ Frozen, firm, and forecast fences cannot overlap or have gaps between them.

■ When multiple fences are defined, firm fences must follow frozen fences and 
forecast fences must follow firm fences.

■ You must enter a From Day before you can enter a To Day.

■ To Days must be greater than or equal to From Days.

■ A NULL From Day means the fence does not apply. The status of demand on 
the schedule or another fence will be updated to the sales order.

■ A ZERO From Day means no demand of this category will be updated to the 
sales order.

■ ZERO is not allowed for Frozen From Day.

■ If a ZERO From Day is specified, all higher From Days must also be ZERO (e.g. 
if Frozen From Days = 0, then Firm and Forecast From Days must also = 0).

■ NON-ZERO NUMBER in From Day and To Day means to calculate an effective 
date range using the schedule’s horizon start date, starting on the From Day 
and ending on the To Day.
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◗◗ To enter processing rules at the customer level:
1. Select Setup>Processing Rules from the main window.

2. From the Release Management Processing Rules window, select the customer 
from the list of values.

3. Click Customer Rules to display the Release Management Processing Rules 
Details window defaulted at the customer level.

4. Enter processing rules as desired.

5. Click OK to return to the Release Management Processing Rules window.

◗◗ To enter processing rules at the address level:
1. Select Setup>Processing Rules from the main window.

2. From the Release Management Processing Rules window, select the customer 
from the list of values.

3. Select the address from the list of values on the Ship-To Addresses tab.

4. Click Address Rules to display the Release Management Processing Rules 
Details window defaulted at the address level.

5. Enter processing rules as desired.

6. Click OK to return to the Release Management Processing Rules window.

◗◗ To enter processing rules at the address item level:
1. Select Setup>Processing Rules from the main window.

2. From the Release Management Processing Rules window, select the customer 
from the list of values.

3. Select the customer item from the list of values on the Ship-To Addresses tab.

4. Click Item Rules to display the Release Management Processing Rules Details 
window defaulted at the address item level.

5. Enter processing rules as desired.

6. Click OK to return to the Release Management Processing Rules window.
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◗◗ To enter processing rules at the customer item level:
1. Select Setup>Processing Rules from the main window.

2. From the Release Management Processing Rules window, select the customer 
from the list of values.

3. Select the customer item from the list of values on the Customer Items tab.

4. Click Item Rules to display the Release Management Processing Rules Details 
window defaulted at the customer item level.

5. Enter processing rules as desired.

6. Click OK to return to the Release Management Processing Rules window.

See Also
Processing Rules

CUM Workbench

Overview of Shipment Delivery Rules

Matching Attributes
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Matching Attributes
Oracle Release Management’s Flexible Matching Logic allows you to identify 
specific attributes used by the Demand Processor for determining if inbound 
schedules are new demand or changes to existing demand. Flexible matching logic 
allows you to match incoming demand with existing demand by defining criteria at 
the address or customer level, thereby giving you the ability to address the needs of 
specific business relationships. Additionally, you can reset these values to 
predefined system defaults at any time. In the Matching Attributes window you can 
view the set of demand processor mandatory and optional matching attributes for 
the current business relationship. 

In this window you can also enable optional attributes which allow you to tailor the 
matching logic to data elements sent by trading partners on planning/release, 
shipping, and sequenced schedules.

Evaluate the data elements your trading partners send with item information on 
planning/release, shipping, and sequenced schedules to determine whether 
optional matching attributes should be enabled. Enable those attributes included on 
the demand schedule from the customer which are unique and should not be 
combined on the same shipment line.

A data element can be a Matching Attribute if any of the following are true:

■ it is required as turnaround data by the trading partner

■ it is a CUM Key component and the trading partner requires CUM 
Management

■ demand associated with a different value for this data element is considered 
unique by the trading partner

Additionally, a data element can be a Critical Attribute if both of the following are 
true:

■ it is required as turnaround data by the trading partner

■ it is enabled as a Within Like Schedule Type matching attribute

If a matching attribute is needed, set the flags for matching Within Like Schedule 
Type and matching Across Schedule Type according to the needs of the business 
relationship:

Attention: The Demand Processor will halt processing if Critical 
Attributes are missing.
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■ Within Schedule Type - Select the Within Schedule Type checkbox if the data 
element is a Matching Attribute when processing demand for this business 
relationship and the existing demand comes from the same schedule type.

■ Across Schedule Type - Select the Across Schedule Type checkbox if the data 
element is included on all types of demand schedules for this business 
relationship and is a Matching Attribute when processing demand, regardless 
of the type of demand schedules from which the existing demand originated.

■ Critical - Select the Critical checkbox if the data element should always have a 
value as turnaround data. If this box is checked and the attribute is missing on 
demand, the Demand Processor will issue a warning exception to identify the 
discrepancy. Before you can enable the data element as a Critical Attribute, you 
must first enable it as a Match Within Attribute.
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◗◗ To enable optional Matching Attributes:

1. Through Setup>Processing Rules on the main menu, navigate to the Release 
Management Processing Rules window.

2. Click Matching Logic to open the Matching Attributes window.

3. Select the checkboxes corresponding to those matching attributes you wish to 
enable.

4. Save your work.
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See Also
Processing Rules

Release Management Processing Rules Details

Overview of CUM Workbench
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Shipment Delivery Rules

This chapter introduces the Shipment Delivery Rules. It explains how to create and 
maintain shipment and delivery pattern codes for Release Management.

■ Overview of Shipment Delivery Rules on page 3-2

■ Maintain Ship/Delivery Pattern Code on page 3-4
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Overview of Shipment Delivery Rules
Customer demand schedules are received indicating either a required shipment 
date or delivery date. When requirements are stated in shipment dates, the supplier 
must ship the material at the specified date/time. If requirements are stated by 
delivery date, the supplier must offset the requirement date by transportation lead 
time and valid delivery dates. With Oracle Release Management’s Shipment 
Delivery Rules you can effectively manage schedule requirements to meet both 
shipment and delivery date shipping requirements.

This chapter explains how to manage shipment and delivery pattern codes in 
Oracle Release Management for calculating the date material should be shipped.

Prerequisites
In order to use the shipment and delivery rules, you must first perform the 
following setup steps:

■ Define Customer Receiving Calendar.

Using the Define Calendars form, set up a calendar to represent your customer 
destination’s receiving days. You can set up one receiving calendar for each 
customer or customer ship-to address, or, alternatively, share the calendar 
among different customers. See: Oracle Shipping Execution.

■ Define Warehouse Shipping Calendar.

■ Using the Define Calendars form, set up a calendar to represent your 
warehouse’s shipping days. You can set up one shipping calendar for all of 
your warehouses or define separate calendars for each warehouse or for groups 
of warehouses. See: Oracle Shipping Execution.

■ Define Transportation Lead Times between you and the customer destination.

When you define the shipping lane between your ship-from organization and 
the customer location, you will indicate the intransit time on the Release 
Management Processing Rules form. This intransit time will be used to calculate 
the scheduled ship date for the customer destination requirements.

■ Verify system defined Ship Delivery Pattern Codes.

Oracle Release Management is seeded with industry-standard ship delivery 
pattern codes. Codes used by the ANSI X12 and EDIFACT standards can be 
viewed and some can be modified on the Maintain Ship/Delivery Pattern 
Codes form.
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■ Add your own Ship Delivery Pattern Codes.

You can define your own ship delivery pattern rules on the Maintain 
Ship/Delivery Pattern Codes form. These codes can then be used as a default 
on the Processing Rules form for either single or multiple customers. If a 
customer uses a standard code in a non-standard way, you can build a custom 
ship delivery pattern code to represent this non-standard use, then use the EDI 
Gateway code conversion functionality to map their code to the code you 
created.

■ Determine default Ship Delivery Pattern Code for a customer destination.

When you define your Processing Rules, you can specify whether to use the 
customer’s ship delivery pattern or override this with your own ship delivery 
pattern code.

■ Associate a default Ship Delivery Pattern Code to a customer destination.

When you define your Processing Rules, you must specify a default ship 
delivery pattern rule for each customer. 

Each default ship delivery pattern rule is used with a flag in the Processing 
Rules Details window that specifies not to use the customer’s ship delivery 
pattern code. When this flag is set to override the EDI transmitted ship delivery 
pattern code, the default ship delivery pattern code set at the Ship From/Ship 
To Processing Rules level will be used instead. This default will also be used if 
the customer does not transmit a Ship Delivery Pattern Code. You can select 
from ship delivery pattern codes defined using the Maintain Ship/Delivery 
Pattern Codes form.

■ Associate a default Ship Delivery Pattern Code to a Ship-From Customer Item.

When you define your ship-from customer item processing rules, you can 
optionally specify a default ship delivery pattern rule to be used for that item. 
This ship delivery pattern rule will be used if you have indicated on the 
Processing Rules form that you do not want to use the ship delivery pattern 
transmitted by the customer on the EDI transaction. You can select from any of 
the ship delivery pattern rules defined using the Maintain Ship Delivery Pattern 
Rules form.

See Also
Maintain Ship/Delivery Pattern Code

Overview of Processing Rules
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Maintain Ship/Delivery Pattern Code
Use this window to view and edit shipment and delivery pattern codes. Oracle 
Release Management will define certain ship and delivery pattern rules with 
associated percentages to represent a subset of the X12 and EDIFACT pattern codes. 
To preserve the integrity of the shipment date calculations that Oracle Release 
Management will automatically perform as part of the Calculate Scheduled 
Shipment Date program, some of the seeded ship and delivery patterns rules are 
not user-maintainable. These will be indicated by an unselected checkbox.

This window displays the following fields for entering and viewing information:

Code  The ship delivery pattern code is displayed in this field. Both the X12 standard 
codes and the EDIFACT standard codes are displayed.

Description  The description associated with the ship delivery pattern code is 
displayed in this field.

Weekday Percentage  This set of fields displays the percentage shipped each day 
under the current ship delivery pattern rule. Each field will default to zero and the 
status bar will indicate the total percentage remaining out of one hundred.

Updatable  This checkbox indicates whether you can update this ship delivery 
pattern code and its associated data. When you define your own ship delivery 
pattern rules, this box is checked.

Trading partners may not always use pattern codes in a standardized way and it 
may be necessary to define your own custom pattern codes.
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◗◗ To define your own custom pattern code:

1. Navigate to the Maintain Ship/Delivery Pattern Codes window by selecting 
Shipment Delivery Rules from the menu.

2. Enter a unique pattern code name in the Code field.

3. Enter a description of the new pattern in the Description field.
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4. Enter daily percentages in the appropriate fields under Weekday Percent. These 
must equal either 100 or zero. Zero is used to indicate a pattern code for which 
you don’t want to change the requested date the customer transmitted. An 
example of this is “Y = None.” Oracle Release Management will not change 
quantities or scheduled ship dates for any demand that uses this pattern code.

5. Save your changes.

6. Navigate to the Release Management Processing Rules window and click 
Address Terms.

7. On the Demand Management tab of the Terms at Address Level window, clear 
the Use Customer’s Ship Delivery Pattern Code checkbox.

8. Enter the previously defined custom pattern code in the Default Ship Delivery 
Pattern field.

9. Click OK to save your changes and proceed.

You can use any of the ship delivery pattern codes (seeded or user-defined) to set a 
default rule at the Ship-From/Ship-To Processing Rules or Ship-From Customer 
Item level. Default rules will be used by the Calculate Scheduled Shipment Date 
program if you indicate you want to override the ship delivery pattern code sent by 
the customer on the EDI transmission or if no ship delivery pattern code was sent 
by the customer when one was expected.

If you want to override the ship delivery pattern code transmitted by the customer 
on the EDI transaction, the Calculate Scheduled Shipment Date program will look 
first at the Ship-From Customer Item level for a default ship delivery pattern code. 
If no code is set at the Ship-From Customer Item level, it will look at the 
Ship-From/Ship-To Processing Rules level where it is mandatory.

See Also
Overview of Processing Rules
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Release Management Workbench

This chapter outlines the Release Management Workbench. It explains how to view 
and enter data in the Workbench.

■ Overview of Release Management Workbench on page 4-2

■ Schedule Summary on page 4-6

■ Overview of Schedule Details on page 4-12

■ Schedule Details - Header View on page 4-14

■ Schedule Details - Lines View on page 4-16

■ Schedule Details - Exceptions View on page 4-22

■ Authorizations on page 4-23

■ Horizontal Demand on page 4-26

■ Horizontal Schedule on page 4-28
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Overview of Release Management Workbench
The Release Management Workbench facilitates the management of customer 
demand by providing visibility to all archived customer demand schedules, the 
current Sales Order demand, and additional Release Management information.

With the Release Management Workbench you can view raw schedules as your 
customers send them before they have been manipulated by the Processing Rules or 
you can view the demand generated from the schedule by the Demand Processor 
after applying processing rules. In addition, you can view the link to the actual sales 
order line which will allow you to see the order status. In this way, the Release 
Management Workbench gives you the ability to evaluate scheduling trends and 
quantity fluctuations to better predict and forecast customer requirements using:

■ Customer Demand Schedules

■ Horizontal Picture of Customer Demand from Schedule

■ Current Customer Demand 

■ Horizontal Picture of Current Customer Demand with Ahead/Behind Status

■ Customer Item Information

■ Shipment History

■ Authorization History

Using the Release Management Workbench, you can also enter manual schedules 
which will be processed in the same way that automated schedules received from 
your customers are processed, from validation to reconciliation.

Process Status Description

Updatable on 
Release 
Management 
Workbench?

Available to Process Indicates the schedule has not yet been validated, archived, or 
managed through the Demand Processor.

Yes

In Process Indicates the schedule has not yet been completely processed 
through the Demand Processor, and should not be viewed.

No

Processed With Error Indicates the schedule has been validated and has fatal errors 
which prevented any further processing of the header or any 
corresponding lines through the Demand Processor. This 
schedule did not update the netted demand.

Yes
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Prerequisites
This section outlines the procedures you should follow to use the features of the 
Release Management Workbench.

Set Up Oracle Applications
In order to use the Release Management Workbench, you need to set up the 
following Oracle Applications:

■ Oracle Receivables. See: Oracle Receivables.

■ Oracle Inventory. See: Oracle Inventory.

■ Oracle Order Management. See: Oracle Order Management.

■ Oracle e-Commerce Gateway. See: Oracle e-Commerce Gateway.

Processed Successfully Indicates the schedule and all its corresponding lines has been 
completely and successfully processed through the Demand 
Processor and has updated the netted demand.

No

Partially Processed with 
Errors

Indicates the schedule has some lines which were fully 
processed and some which did not. Check the status of the 
corresponding lines.

Yes, for errored 
lines

Process Status Description

Updatable on 
Release 
Management 
Workbench?
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Set Up Release Management 
Before you can use the Release Management Workbench you must perform the 
following setup tasks for Oracle Release Management:

■ Use the Release Management Processing Rules Form to: 

■ associate Ship-From Organizations with the Customer Locations from 
which you receive demand transactions.

■ define the applicable CUM Management Type for each of these 
Ship-From/Ship-To business entities.

■ associate the Ship-From Organizations with the Customer Items.

■ associate the Pricing Agreement referencing the applicable Purchase Order 
with the Customer Items.

■ Use the Release Management Processing Rules Form to:

■ enter Customer Items associated with the Customer or Address.

Note: Entering Customer Items at this level is only necessary 
when you wish to define separate processing rules for the Item 
Level.
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Tools Menu
The Tools Menu provides access to additional windows, processing, and forms 
which support Release Management. The following functions are available from 
this menu:

■ Workflow Monitor - choose Tools>Workflow Monitor to display the Workflow 
Monitor window. In this window, you can find a diagrammatic representation 
of the activities in the Demand Processor to view the status of workflow 
processes. See the Workflow User’s Guide for more information.

■ Workflow Status - choose Tools>Workflow Status to display the Workflow 
Status window. This window shows a table of all the activities executed within 
the process instance and the status of each. See the Workflow User’s Guide for 
more information.

■ Authorizations - choose Tools>Authorizations to display the Authorizations 
window. See: Authorizations.

■ Submit Demand Processor - choose Tools>Submit Demand Processor to submit 
the current schedule to the Demand Processor concurrent process. This is not 
available for fully processed schedules. See: Release Management Demand 
Processor.

■ Processing Rules - choose Tools>Processing Rules to open the Release 
Management Processing Rules form for the Customer associated with the 
current schedule. See: Release Management Processing Rules.

■ CUM Workbench - choose Tools>CUM Workbench to open the CUM 
Workbench form with detail associated with the current schedule. See: CUM 
Workbench.

See Also
Schedule Summary

Overview of Schedule Details

Line Addresses Details

Horizontal Demand

Horizontal Schedule

Overview of CUM Workbench
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Schedule Summary

The primary window in the Release Management Workbench is the Schedule 
Summary window. You can view all schedules in this window, as well as manually 
enter new schedules. The Schedule Summary window is composed of two parts: 
on the left, the Query Navigation Tree, and on the right, the Summary tab.
4-6 Release Management User’s Guide



Schedule Summary
Queries
On the left side of the Workbench, the Query Navigation Tree lists all public queries 
and any private queries you have created. All users can see and use public queries, 
no matter who created them. Private queries are only available to the user who 
created them. The icon for each query identifies it as public or private.

■ Single-click on any query to execute it. The Summary tab on the right will 
display schedule header data.

■ Right-click on any query to gain access to the query menu:

■ New Query allows you to create a new query from the current Query while 
leaving the original Query intact

■ Edit Query allows you to modify the parameters of the current Query

■ Delete Query allows you to delete the current Query if it is a Private Query 
you have created
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Find Window

If you select either New Query or Edit Query from the query menu, the find 
window will display for you to enter search parameters. This window has two tabs, 
Basic and Advanced, on which you can enter a number of optional parameters for 
limiting the query to demand associated with these attributes.
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Tabbed Regions
■ Basic--includes the following parameters: customer name and number, 

ship-from organization, customer ship-to location, schedule reference number, 
schedule type, schedule purpose, schedule source, horizon start date range, 
schedule issue date range, and customer item range.

■ Advanced--includes the following parameters: pull signal reference number, 
process status, customer PO number, production sequence number, customer 
intermediate ship-to location, processed date range, inventory item range and a 
checkbox for newest schedule.

Summary Tab
The right side of the Schedule Summary window displays a table of all schedule 
headers, both processed and unprocessed, matching the selection criteria. You can 
open the Schedule Details window to view the current schedule in greater detail by 
pressing one of three buttons at the bottom of the tab: Header, Lines, Exceptions.

The last column on the right of each schedule displays the process status of the 
schedule. Each schedule is listed as Available to Process, Processed with Errors or 
Processed Successfully. Additionally, these fields are color-coded: yellow for 
Available to Process and red for Processed with Errors.
Release Management Workbench 4-9



Schedule Summary
◗◗ To view a schedule:
1. Navigate to the Schedule Summary window through Release 

Management>Release Management Workbench on the main menu.

2. Right-click in the query navigation tree to gain access to the query menu.

3. From the query menu, select new query.

4. In the Find window, enter the desired search criteria.

5. Press Find to search for a schedule.

6. In the results portion of the query window, select a schedule to view.

7. Press Open Schedule to view the schedule in the Release Management 
Workbench.

Note: The Process Status field on the Advanced tab of this 
window enables you to search for schedules by current status. In 
this way, you can search for either processed or unprocessed 
schedules.
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◗◗ To save a query:

1. In the Find Window of the Release Management Workbench, press the Save 
As... button.

2. In the Save The Query? window that displays, enter a query name.

3. Select the Public Query checkbox if you want this query to be public.

4. Save your work.

Your new query will now be included in the query navigation tree on the left of 
the Release Management Workbench. As with other queries, you can 
single-click on your new query to execute it.
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Overview of Schedule Details
The Schedule Details window allows you to view schedule item information in a 
convenient, well-organized way. Three views of schedule information are available:

Header View
This view displays schedule header information. See: Schedule Details - Header 
View.

Lines View
This view will display schedule data in two different formats, non-sequenced and 
sequenced, depending on the current schedule type. See: Schedule Details - Lines 
View.

■ Non-Sequenced

This view groups schedule lines by ship-from organization, ship-to address and 
customer item (appropriate for Planning or Shipping Schedules; alternative 
view for Sequenced Production Schedules). The left side of the window lists the 
ship-from organization, ship-to address, and customer item included on the 
schedule. The right side of the window displays corresponding schedule item 
information and lines for the current ship-from organization, ship-to address, or 
customer item. See: Schedule Details - Lines View.

■ Sequenced

This view groups schedule lines by ship-from organization, ship-to address, 
and date (appropriate for Sequenced Production Schedules). The left side of the 
window lists ship-from organization, ship-to address, and date included on the 
schedule. The right side of the window displays corresponding schedule 
information and lines for the current business relationship. See: Schedule 
Details - Lines View.

Exceptions View
This view displays information about exceptions (both warnings and errors) 
generated during the most recent run of Demand Processor for the current 
schedule. When a schedule has an error status, data may be corrected in the 
Workbench and re-submitted to the Demand Processor. See: Schedule Details - 
Exceptions View.
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◗◗ To enter a schedule manually:
1. Navigate to the Schedule Summary window through Release 

Management>Release Management Workbench on the main menu.

2. Select File>New.

3. In the Header view of the Schedule Details window, enter data in the 
appropriate fields.

4. Select the Lines view of the Schedule Details window and enter data in the 
appropriate fields.

5. Save your work.

◗◗ To submit a schedule for processing:
1. Navigate to the Schedule Details window of an unprocessed schedule you wish 

to submit for processing.

2. Select Tools>Submit Demand Processor.

◗◗ To view exceptions on a schedule:
1. Navigate to the Schedule Summary window through Release 

Management>Release Management Workbench on the main menu.

2. Right-click in the query navigation tree to gain access to the query menu.

3. From the query menu, select new query.

4. In the query window, enter the desired search criteria.

5. Press Find to search for a schedule.

6. In the results portion of the query window, select a schedule to view.

7. Press Open Schedule to view the schedule in the Release Management 
Workbench.

8. In the Summary Schedule window, select the appropriate schedule.

9. Press Exceptions to open the Exceptions View of the Schedule Summary 
window.
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Schedule Details - Header View

The Header View displays schedule header information using two tabs: Schedule 
and Other. This window displays when you:

■ Click Header in the Summary window to view details of currently selected 
schedule

■ Click Open Schedule in the Query Results region of the Find window
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Tabbed Regions
■ Schedule--displays information in three regions. Across the top of the tab, you 

will see fields pertaining to the schedule itself, including schedule number, 
schedule source and further information about type, purpose and issue date. 
Also, the start and end horizon dates are presented with processing dates.

The Customer region on the lower left of the tab shows the customer 
information relating to this schedule, including the name and address of the 
customer, as well as the customer code.

On the lower right of this tab, the Trading Partner region shows the EDI trading 
partner codes and EDI control numbers which correspond to the schedule.

■ Other--the Header Contacts region shows schedule level contact information 
including contact codes and values. Header References shows corresponding 
schedule level reference code and value pairs.
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Schedule Details - Lines View

Non-Sequenced View
This window displays the schedule details in non-sequenced view mode. Two tabs 
on the left side, Internal and External, distinguish between the codes the customer 
sent on the schedule (External) and the data these codes were converted to by the 
Demand Processor (Internal).

■ Information common to all details of the schedule’s ship-from organization, 
ship-to address, or customer item is shown on the left side & upper right side of 
the window.
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■ All the schedule lines for the currently selected ship-from organization, ship-to 
address, or customer item are displayed on the lower right section of the 
window.

Upper Tabbed Regions
■ Item--displays general attributes sent on the schedule by the customer 

describing the physical item and status, including the following parameters: 
supplier item and description, item and description, assigned ID, origin, 
commodity code, model number, engineering change, revision, measurements, 
record year, release status, ship delivery pattern and ship delivery time.

■ Locations--displays information relating to addressing, including bill-to, 
intermediate ship-to, customer dock code, other business entity names and any 
notes you may have for this schedule. 

Additionally, by clicking Addresses on this tab, you can view the Line 
Addresses Details window which will display complete mailing address for 
ship-from, ship-to, bill-to and intermediate ship-to locations for the present 
schedule. See: Line Addresses Details.

■ Purchasing--displays information relating to the purchase order and 
import/export licenses, including the following parameters: number, date, 
release, line and contract number of the purchase order, import license number 
and date, letter of credit number and expiration date, customer price and UOM.

■ Mfg.--displays information relating to manufacturing, including production 
sequence number, manufacturer, model serial number, lading quantity, 
production line, assembly, process, job number, set number, order, contractor 
part and any notes you may have for the current schedule.

■ Packing--displays information relating to packing, including handling code, 
returnable container code, hazardous material information, standard pack, bar 
code labels and free-form shipping label information to be used by third party 
software systems.

■ Transport--displays information relating to transport of the current schedule, 
including carrier qualifier and code, routing sequence and description, transit 
qualifier and time, equipment type and number, transport qualifier, transport 
location, transport method, weight, weight qualifier and UOM.

■ Other--displays codes and values for Item References and Contacts for the 
current schedule.
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The lower right section of this window displays schedule lines for the selected 
ship-from organization, ship-to address, or customer item. It display each in a 
multi-row format sorted by sequence number, detail type and subtype. Three sets of 
flexfields (schedule, industry, and trading partner) are accessible if enabled under 
the Others tab.

Lower Tabbed Regions
■ Lines--displays information relating to the line item, including quantity type, 

quantity, UOM, data type, start date, corresponding external values and end 
date.

■ References--displays miscellaneous code and value pairs, pull signal reference 
and serial numbers associated with the detail.

■ Other--displays the sequence number, description, configuration code, assigned 
ID, quantity, UOM, customer item number, model number, process status, and 
three flexfields.

Buttons
The following buttons are available in the Non-Sequenced Schedule Results 
window:

■ Horizontal Schedule--click Horizontal Schedule to view the schedule demand 
for the current ship-from organization, ship-to address, or customer item in a 
horizontal bucketed format showing demand type, bucket type, start date, 
bucket quantity, UOM, and CUM demand quantity. Shipment and receipt 
information included on the schedule will also be displayed. See: Horizontal 
Schedule.

■ Shipments--click Shipments to view shipments associated with the current 
ship-from organization, ship-to address, or customer item.

■ Demand--click Demand to view the sales order demand associated with the 
current row of schedule demand.

■ Horizontal Demand--click Horizontal Demand to view the sales order demand 
in horizontal time buckets associated with the current ship-from organization, 
ship-to address, or customer item. See Horizontal Demand.
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Sequenced View

This window displays the schedule details in sequenced view mode. On the left is 
the current ship-from organization, ship-to address, and start date information 
which corresponds to schedule lines outlined in further detail on the right.
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This view of the Schedule Details window groups schedule lines by ship-from 
organization, ship-to organization, and start date (appropriate for sequenced 
production schedules). The leftmost set of tabs identifies all combinations of 
organization, ship-to and start date contained in the schedule. Two tabs, Internal 
and External, which distinguishes between the codes the customer sent on the 
schedule (External) and the data these codes were converted to by the Demand 
Processor (Internal).

The right side of the window includes tabs that display lines of detail associated 
with the current ship-from organization, ship-to address and start date. Also listed 
at the bottom of these tabs is the customer item and description, item and 
description, quantity, UOM and process status for the current item.

Tabbed Regions
■ Lines--displays information relating to lines on the schedule, including 

production sequence number, customer item, quantity type, quantity, UOM, 
detail type, sub type, production line, model serial number, job number, dock, 
assembly, process, external values, order and data type.

■ Item--displays information relating to the customer item, including transaction 
sequence, customer item, UOM, assigned ID, supplier item, description, origin 
code, model number, commodity, engineering change, revision, measurements, 
record year, number, release, date, line, ship delivery pattern, ship delivery time 
and release status.

■ Locations--displays addressing information, including intermediate ship-to and 
bill-to addresses for this schedule.

■ References--displays information relating to item detail references including 
code and value pairs. Also displayed are start and end serial numbers and a 
reference number for each transaction sequence.

■ Other--displays additional information relating to each transaction sequence, 
including sequence number, description, assigned ID, quantity, UOM, customer 
item, model number, configuration code and three flexfields.
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Buttons
The following buttons are available in the Sequenced Schedule Results window:

■ Demand--click Demand to view the sales order demand associated with the 
current row of schedule demand.

■ Shipments--click Shipments to view shipments associated with the current 
ship-from organization, ship-to address, or customer item.

■ Horizontal Demand--click Horizontal Demand to view the sales order demand 
in horizontal time buckets associated with the current ship-from organization, 
ship-to address, or customer item. See: Horizontal Demand.
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Schedule Details - Exceptions View

The Exceptions View of the Schedule Details window displays information about 
warnings and errors generated during the most recent run of Demand Processor for 
the schedule.

On the Release Management Workbench and in the Schedule Details - Exceptions 
View window, the exception status is color-coded for easier viewing:

■ gray - processed successfully

■ yellow - available to process

■ red - processed with errors
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When a schedule has an error status, data may be corrected in the Workbench and 
re-submitted to the Demand Processor. See: Release Management Demand 
Processor.

Authorizations

Authorizations are the customer’s promise to pay for costs incurred for procuring 
material with long lead times or producing items regardless of whether or not they 
are ultimately shipped to the customer. Different types of authorizations, such as for 
raw material or finished goods, may be included in planning schedules and 
material release transactions.
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You can access the Authorizations window from the Tools Menu while looking at 
either the Header or Lines View of the Schedule Details window. This window 
displays the complete authorization history for the current ship-from organization, 
ship-to address, or customer item.

◗◗ To view authorizations for a schedule:
1. Navigate to the Schedule Summary window through Release 

Management>Release Management Workbench on the main menu.

2. Right-click in the query navigation tree to gain access to the query menu.

3. From the query menu, select new query.

4. In the Find window, enter the desired search criteria.

5. Press Find to search for a schedule.

6. In the results portion of the query window, select a schedule to view.

7. Press Open Schedule to view the schedule in the Release Management 
Workbench.

8. In the Schedule Details window of the schedule for which you want to view an 
authorization, select Tools>Authorizations.

9. The Authorizations window will open with data corresponding to the current 
schedule.

The upper portion of the Authorizations window displays all authorizations in 
reverse chronological order from all customer demand schedules archived by the 
Demand Processor. This includes schedule number, type, date type, start and end 
dates, quantity type, quantity and UOM.

The middle portion of this window displays information on the CUM Keys, 
including start date, record year, PO number, billing, shipping and delivery 
addresses.

Note: The Process Status field on the Advanced tab of this 
window allows you to search for schedules by current status. In 
this way, you can search for either processed or unprocessed 
schedules.
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The lower portion of the window identifies the highest authorizations from 
customer demand schedules for each CUM period associated with the ship-from 
organization, ship-to address, or customer item, if the current Ship-To Location is 
managed by CUM accounting rules. This includes schedule number, schedule type, 
date type, start and end dates, quantity type, quantity and UOM.

See Also
Schedule Details - Lines

Overview of CUM Workbench
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Horizontal Demand

This window displays open demand from the Sales order form for the current 
schedule item in horizontal format with cumulative quantities.
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The current item information is displayed in three regions:

■ at the top of the window is the current start and end dates and the refresh 
button;

■ in the center of the window, in horizontal format, the current status, bucket 
type, schedule ship date, open quantity, shipped quantity, CUM demand 
quantity, CUM shipped quantity and ahead/behind estimate is reported for 
open demand;

■ the bottom portion of the window reports CUM management information 
including CUM type, CUM entity, UOM, CUM quantity, last update date, CUM 
start date, record year, PO number and billing address.

Buttons
■ Refresh--press to refresh the window with the current item information.

See Also
Schedule Details - Lines

Overview of CUM Workbench

Note: CUM demand data displayed in this window varies 
dependent on the date range selected at the top of the window.
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Horizontal Schedule

This window displays demand for the current schedule item in horizontal format 
with cumulative quantities.

The current schedule item information is displayed in two regions. At the top of the 
window, in horizontal format, is the demand type, bucket type, start date, bucket 
quantity, UOM, and CUM quantity. The lower half of the window contains the 
shipment and receipt information for the current schedule, including subline type, 
date type, start and end dates, quantity type, quantity, UOM, detail reference I (code 
and value).
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See Also
Schedule Details - Lines

Workflows
Oracle Release Management is workflow enabled. By running the Demand 
Processor with workflow enabled, you can access the Workflow Monitor and 
Workflow Status windows for additional information on the specific processes 
within the Demand Processor. You can view a diagrammatic representation of the 
basic activities of the Demand Processor, including Validate Demand Flow, Manage 
Forecast Flow, Manage Demand Flow, and Reconcile Demand Flow. In this way, 
you can see the actual flow of the transaction and know whether each completed 
successfully without exceptions, failed with valid exceptions or aborted due to 
other issues. For more information about workflows in Oracle Applications, see the 
Oracle Workflow User’s Guide.
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CUM Workbench

This chapter describes Release Management CUM Workbench. It explains how to 
view and edit cumulative accounting information using the CUM Workbench.

■ Overview of CUM Workbench on page 5-2

■ CUM Management on page 5-6

■ CUM Workbench on page 5-7

■ CUM Key Details on page 5-9

■ Creating a CUM Key on page 5-12

■ Entering a CUM Adjustment on page 5-10
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Overview of CUM Workbench
In some industries, including the automotive industry, cumulative accounting, or 
CUM processing is mandated by many customers. CUM accounting entails a 
trading partner sending a discrete quantity with a cumulative ship-to-date quantity 
which indicates their order over a specified period.

In cases in which trading partners send CUM quantities instead of discrete 
quantities, Oracle Release Management allows you to process, reconcile and convert 
these CUMs to a discrete quantity you can more easily manage.

Prerequisites
CUM Management is composed of three primary tasks: preprocessing setup, daily 
processing, and CUM rule change processing. Here is a brief overview of this 
process:

Setup:
1. Define your customer’s CUM rule with each ship-from organization, and define 

any variations for related shipping addresses. Furthermore, you can explicity 
disable CUM management for customer items at the items or items/address 
level.

Customers may have different methods for calculating CUMs. A customer’s 
CUM rule defines how you calculate the CUMs for that customer. The CUM 
rule for each customer is set on the Release Management Processing Rules form. 
All CUM Rule attributes are found on the CUM Management tab at the 
customer or address level, except the CUM start date and the customer 
purchase order number, which are both derived from the latest customer 
demand schedule. On this form, you can specify whether or not the customer 
uses CUMs. If so, this is where you indicate the significant attributes of the 
CUM rule, including record year, shipment inclusion rule, etc. See: CUM Key 
Details.

2. Create CUM Keys. (Optional) See: Creating a CUM Key.

3. Perform a CUM adjustment transaction to set the beginning CUM quantity. 
(Optional)

The CUM Adjustments feature on the CUM Workbench form lets you set the 
CUM for a particular item/CUM key combination. See: Entering a CUM 
Adjustment.
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Daily Processing:
1. Receive demand from your customer with their CUM value included.

As part of Oracle Release Management, you will receive electronic demand 
from your customer. If your customer uses CUM processing, the electronic 
demand will include the customer’s current CUM for each item. This 
information will be stored in the Release Management Schedule Archives for 
each schedule, and will also be used in the demand processor to report any 
descrepancies between your CUM and your customer’s CUM, and to derive 
new and changed demand from your customer.

2. Adjust the customer’s demand to account for any in-transit shipments.

Compare the customer’s last received shipment with the last shipment sent to 
search for any in-transit shipments not included in the customer’s CUM. If a 
discrepancy exists, the demand processor will adjust incoming demand to 
account for these in-transit shipments.

3. Calculate CUM on your shipments.

CUM Calculation is done with Shipping Confirmation if the 
Ship-From/Ship-To business entity is under CUM Management and the item 
being shipped is CUM enabled.

CUM Calculation for CUM enabled items includes the following events:

■ The CUM is calculated based on CUM Management and Shipment 
Inclusion Rules defined for the Ship-From/Ship-To business entity.

■ The calculated CUM is stored in a sales order line industry attribute and 
referenced on shipping documents and loaded into the EDI Gateway DSNO 
flat file.

■ The applicable CUM Key ID is assigned to each sales order line.

■ The CUM Key CUM quantity is updated based on Shipment Inclusion 
Rules.

4. Compare the customer’s CUM value on the inbound demand to your current 
CUM value.

The demand processor will compare current calculated CUM residing in Oracle 
Applications to the CUM sent by the customer to reflect shipments and CUM 
adjustments for the current item, including in-transit shipments. An exception 
report is generated to indicate any discrepancies.
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5. If discrete quantities are not sent in the demand, calculate discrete quantities 
using the customer’s CUM.

If the customer has indicated demand in cumulative rather than discrete 
quantities, the demand processor will calculate discrete quantities for easier 
importing into Oracle Order Management as a sales order line.

6. View sales order information with corresponding CUM information.

The Release Management Workbench displays sales order information with the 
appropriate CUM information on the Horizontal Demand window.

7. View CUM information on the Release Manachement Workbench, CUM 
Management Workbench and Release Management reports.

The Release Management Workbench will display CUM information relating to 
the current schedule. The CUM Management Workbench will display the 
shipment transactions and adjustments that compose an item’s CUM. Demand 
reports in the Release Management Workbench will also display CUM 
information, with ahead and behind visibility.

Note: The Horizontal Demand window is the only display of sales 
order information which includes corresponding CUM 
information.

Note: If problems occur when updating the CUM within the 
shipment process, you may have to rerun certain processes or 
adjust the CUM manually in order to prevent CUM discrepancy.
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CUM Change Processing:
1. Create a new CUM Key when the customer resets the CUM.

Occasionally, customers will reset their CUMs. When this happens, you need to 
create a new CUM Key on the CUM Workbench form with information on the 
new CUM. 

2. Adjust the CUM key identifier on shipment transactions if the customer’s CUM 
key needs to be back-dated. (Optional)

When the customer resets the CUM, they may choose to backdate the CUM 
start date so that it has already passed. When this happens, you will need to 
reset the CUM Key ID on shipment and CUM adjustment transactions that have 
occurred since the start date of the new CUM Key. By using the Adjust CUM 
Transactions CUM Key ID program to do this, you can be sure that all shipment 
transactions and CUM adjustment transactions that are affected will recalculate 
the CUM for the old and new CUM Keys.

See Also
CUM Management

CUM Workbench

CUM Key Details

Creating a CUM Key

Entering a CUM Adjustment
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CUM Management
On certain occasions, you may need to access and change CUM information based 
on customer request or internal adjustments. With the CUM Management 
Workbench you can:

■ Make adjustments to a CUM

■ View the shipments that make up the CUM

■ Create new CUM Keys

Queries
The Query window allows you to specify selection criteria for querying the CUM 
Workbench or to go directly to the CUM workbench window without querying. 
Start date and end date are used for querying shipments.

See Also
CUM Workbench

Attention: If you are using CUM Management, records must be 
processed through the Demand Processor for the CUM to be 
updated. To ensure that CUMs for manually entered records are 
updated correctly, enter these records in the CUM Workbench, 
not through Order Management.
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CUM Workbench
CUM Workbench

This window allows you to choose a customer and view the corresponding CUM 
Management information. It displays all corresponding ship-to site use and 
inventory organization relationships which have been associated with the selected 
customer in Oracle Release Management. Current CUM Management information 
for each site use relationship is displayed. You can also see ship-from organization, 
ship-to address, and customer items for current shipping addresses.

You can view corresponding CUM key information associated with current Ship- 
From/Ship-To business entity by clicking CUM Key.
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CUM Workbench
The CUM Workbench is separated into three regions:

At the top of the workbench with the ship-from organization code and name is the 
current customer information, including customer name and number.

The Ship-To Locations region displays addressing information, including: ship-to 
location code, EDI trading partner location code, CUM type, CUM Management 
organization level, CUM current start date, current record year, shipment rule, and 
cut-off time.

The Ship-From/Ship-To Customer Items region of this form shows the following 
information relating to the current customer item: ship-to location, customer item, 
customer item description, preferred item, current CUM start date, pricing contract, 
and purchase order number.

Buttons
■ CUM Key--click CUM Key to display the CUM Key Details window for the 

current record.

See Also
CUM Management

CUM Key Details
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CUM Key Details
CUM Key Details
The CUM Key Details window displays CUM Key information including all 
associated shipment details and adjustment information relevant for the current 
business entity.

This window is separated into two regions:

At the top of the CUM Key Details window, you will see information relating to the 
current CUM Key, including CUM quantity, UOM, CUM start date, record year, 
customer purchase order, and last CUM update date.

The lower portion of the CUM Key Details window contains two tabs.

Tabbed Regions
■ Shipments--displays CUM quantity, transaction date, quantity, UOM, delivery 

name, ship-from location code, ship-to location, deliver-to location, bill-to 
location, and last shipped by user.

■ Adjustments--displays transaction date, quantity, UOM, adjustment reason, 
reference, and last adjusted by user.

Buttons
■ Create CUM Keys--opens the Create CUM Keys window.

■ Enter Adjustments--opens the Enter a CUM Adjustment window.

See Also
Creating a CUM Key

Entering a CUM Adjustment

Note: The total CUM is composed of shipments and adjustments. 
If an adjustment was made between one shipment and another, the 
running CUM on the shipments window will not appear to be 
consecutive, i.e. the previous running CUM quantity plus the 
quantity on the current shipment line will not equal the new 
running quantity.
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Creating a CUM Key
The Create CUM Key window allows you to create and define CUM Keys for 
specific business entities. For example, you will create a CUM Key when you need 
to enter a CUM Adjustment transaction to record the starting CUM Quantity before 
the first shipment of Oracle Release Management demand.

◗◗ To create a CUM Key:
1. Select CUM Workbench from the main menu.

2. Select Org, Item, etc.

3. Press CUM Key to open the CUM Key Details window.
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Creating a CUM Key
4. Click Create CUM Key.

5. Verify and change billing and shipping address values in the Create CUM Keys 
window.

6. Click OK to create CUM Key and continue.

See Also
CUM Key Details

Entering a CUM Adjustment

Note: You cannot open this window if the CUM Management 
Type of the current Ship-From/Ship-To business entity is No CUM.
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Entering a CUM Adjustment
This window allows you to create a CUM Adjustment Transaction associated with 
the current CUM Key for the current ship-from customer item of the current 
business entity. You can enter only one CUM adjustment at a time for the current 
record in the CUM keys block.

◗◗ To enter a CUM Adjustment:
1. Select CUM Workbench from the main menu.

2. Select Org, Item, etc.

3. Press CUM Key to open the CUM Key Details window.
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Entering a CUM Adjustment
4. Click Enter Adjustments to open the Enter a CUM Adjustment window.

5. Enter the CUM Adjustment transaction date.

This field defaults to the current system date and time. Enter the time if the 
customer’s CUM Management Shipment Calculation rule has an associated 
cut-off time.

6. Enter the CUM Adjustment Quantity in the displayed unit of measure. This 
quantity cannot be zero. If you wish to reduce the cumulative shipped quantity, 
enter a negative number here.

7. Enter the reason code for this CUM Adjustment. This can be any of those 
defined in Oracle Inventory.

8. Enter any additional text to describe this CUM Adjustment. 

9. Click OK to enter CUM Adjustment and continue.

See Also
CUM Key Details

Creating a CUM Key

Oracle Inventory User’s Guide.

Note: If the CUM Management Type for this business entity is 
CUM By Date, CUM By Date/Record keeping year, CUM By 
Date/PO, or CUM Until Manual Reset at Item, this date cannot be 
earlier than the cumulative period start date for the CUM Key.

Note: The total CUM is composed of shipments and adjustments. 
If an adjustment was made between one shipment and another, the 
running CUM on the shipments window will not appear to be 
consecutive, i.e. the previous running CUM quantity plus the 
quantity on the current shipment line will not equal the new 
running quantity.
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Reports and Processes

Overview of Reports and Processes
Oracle Release Management provides you with a variety of reports that provide 
release and demand management information, and processes, which enable the 
automation of the release management process. Each of the following sections 
includes an overview of the report and the submission process, as well as a 
description of submission parameters.

Reports
■ Demand Status Inquiry Report on page 6-2

■ Net Change Report on page 6-5

■ Release Management Exceptions Report on page 6-7

■ Release Management Retro Billing Report on page 6-10

Process Inbound Transactions
■ EDI Inbound Transactions on page 6-11

Demand Transactions
■ Release Management Demand Processor on page 6-13

CUM Key Adjustment
■ CUM Transactions CUM Key Adjustment on page 6-17
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Demand Status Inquiry Report
Demand Status Inquiry Report
The Demand Status Inquiry Report reports on netted demand, demand in the 
context of CUM Management and current resource authorizations issued by trading 
partners. Use this report to get a detailed picture of sales order and forecast demand 
for a particular warehouse, customer, customer ship-to, or item in Order 
Management.

The Demand Status Inquiry Report prints the following:

■ Firm Requirements - including customer item, requirement date, order number, 
address abbreviation, unit of measure, required quantity, shipped quantity, 
cancelled quantity, pick released quantity, back-ordered quantity, invoiced 
quantity, job number, production sequence number, and

■ Forecasts - including requirement date, address abbreviation, forecast name, 
forecast level, unit of measure, and required quantity.

Submission

◗◗ To run the Demand Status Inquiry Report:
1. Through Reports on the menu, navigate to the Submit Requests window.

2. Select Single Request.

3. Select Demand Status Inquiry Report from the available list of values.

4. Enter required and optional parameters.

5. Choose Submit to submit the process.

Parameters

Ship-From  

Enter the shipping organization or supplier to limit the report to demand for a 
specific organization. 

Customer Name  

Enter the customer name to limit the report to demand for a specific customer. 
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Demand Status Inquiry Report
Ship-To  

Enter the shipping address to limit the report to demand for a specific shipping 
location associated with the selected trading partner. 

Intermediate Ship-To  

Enter the delivery location to limit the report to demand for a specific location 
associated with the selected trading partner. 

Title  

Define the title that will be printed on the report. The default is Demand Status 
Inquiry Report.

Requirement Date Range  

Enter beginning and ending requirement dates to limit the report to requirements 
within a specific range of scheduled ship dates. 

(C)ustomer or (I)nventory Item  

Enter “I” to limit the report to requirements for a range of inventory items. You can 
then enter a range of inventory items for the report.

Enter “C” to limit the report to requirements for a range of customer items. You can 
then enter a range of customer items for the report. 

Item Range  

Select a range of items to be printed in the report. 

Order Range  

Select a range of orders to limit the report to requirements associated with a specific 
range of sales orders. 

Requirements (F)irm, F(O)recast, (B)oth  

Select the desired requirement status for the report: firm, forecast, or both. The 
default is Both.

Include Canceled Lines (Y/N)  

Enter Yes to include fully canceled sales order lines. Enter No to omit canceled sales 
order lines. The default is No.
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Demand Status Inquiry Report
(S)hipped, (U)nshipped or (B)oth  

Select from three options for reporting on Sales Order Lines based on their 
shipment status: Shipped, Unshipped, or Both. The default is Both.

■ Shipped - includes only shipped sales order lines; excludes unshipped and 
canceled lines. This option supersedes the value for the Include Canceled Lines 
parameter.

■ Unshipped - includes only unshipped sales order lines; excludes shipped lines. 
Canceled lines can be included or excluded based on the value for the Include 
Canceled Lines parameter.

■ Both - includes both shipped and unshipped sales order lines. Canceled lines 
can be included or excluded based on the value for the Include Canceled Lines 
parameter.

Summarize by Date & Bucket (Y/N)  

Enter Yes to summarize demand from sales order lines which have the same 
requirement date and bucket. Enter No to view specific identifiers which have 
resulted in multiple Sales Order lines for the same requirement date and bucket. 
The default is No.

Include Current Resource Authorizations (Y/N)  

Enter Yes to include current resource authorizations on the report. Enter No to omit 
current resource authorizations. The Current Resource Authorizations section of the 
report will print only that demand from planning/release schedules that include 
resource authorizations. The default is Yes. 
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Net Change Report
Net Change Report
The Net Change Report will display any changes that a trading partner has made to 
requirements based on a comparison of any two schedules. Use this report to track 
increases or decreases in requirements from the trading partner. This allows you to 
better monitor requirement fluctuations for seasonal or sporadic changes. With this 
report, you can monitor changes by customer, customer ship-to, item or item range. 
You can define a percentage of change acceptable and report only those items which 
change outside of the tolerance limits. 

The information contained in this report is obtained from archived schedule data 
within Oracle Release Management. This report can only be run for those schedules 
which have been successfully validated and archived.

Submission

◗◗ To run the Net Change Report:
1. Through Reports on the menu, navigate to the Submit Requests window.

2. Select Single Request.

3. Select Net Change Report from the available list of values.

4. Enter required and optional parameters.

5. Choose Submit to submit the process.

Parameters

Customer  

Enter the external customer for which this report is to be run. This field is 
mandatory if no trading partner is selected.

Schedule Type  

Select the schedule type to be compared: Planning/Release, Sequenced or Shipping.

New Schedule  

Enter a new schedule number to restrict the report to specific schedule numbers.
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Net Change Report
Old Schedule  

Enter a valid old schedule number. This schedule must be of the same type as the 
schedule entered in New Schedule.

Ship-From  

Enter the ship-from location for which this report is to be run.

Ship-To  

Enter the shipping address for which this report is to be run.

Customer Item Start  

Select a customer item starting range for the schedules to be compared. This field is 
mandatory if Customer Item End is completed.

Customer Item End  

Select a customer item ending range for the schedules to be compared. This field is 
mandatory if Customer Item Start is completed.

Production Sequence Start  

Enter a date for the customer’s production sequence starting range for the 
schedules to be compared. This field is mandatory if Production Sequence End is 
completed.

Production Sequence End  

Enter a date for the customer’s production sequence ending range for the schedules 
to be compared. This field is mandatory if a Production Sequence Start is 
completed.

Include Authorization Quantities (Y/N)  

Enter Yes to include authorized quantities in this report. The default value is No.

Include Other Detail (Y/N)  

Enter Yes to include other detail types in the report. The default value is No.

Include Lines with no change (Y/N)  

Enter Yes to include lines with no change in this report. The default value is Yes.
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Release Management Exceptions Report
Include Percentage Change More Than  

Include in the report only those lines changed by at least this percentage.The default 
value is 0%.

Release Management Exceptions Report
The Release Management Exceptions Report provides explanatory information for 
errors generated when a problem is encountered during demand processing. Some 
examples of exceptions generated when requirements have not been met are:

■ customers, billing and shipping addresses must exist in Oracle Receivables,

■ orders, including Sales Order and Order Type, must already exist in Oracle 
Order Management,

■ items must be active items defined in Oracle Inventory,

■ forecast names must be defined in Oracle Master Scheduling/MRP,

■ redundant firm requirements are encountered, or

■ discrepancy in the CUM.

This report prints a report cover page section and a report main section which 
includes:

■ request ID and schedule header identifiers,

■ order number, order type and message category, 

■ schedule line identifiers and exception message text, 

■ optional detailed exception text.

Submission
This report is automatically generated when the Demand Processor runs if 
exceptions (information, warning and error) were generated during processing. See: 
Release Management Demand Processor.
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Release Management Exceptions Report
◗◗ To run the Release Management Exceptions Report manually:
1. Through Reports on the menu, navigate to the Submit Requests window.

2. Select Single Request.

3. Select Release Management Exceptions Report from the available list of values.

4. Enter required and optional parameters.

5. Choose Submit to submit the process.

Parameters

Request ID Range  

Enter a range of request numbers to limit the report to exceptions noted for specific 
request identifiers.

External Ship-From  

Enter the shipping location to limit the report to exceptions noted for a specific 
location.

External Customer Name Range  

Enter a range of customer names to limit the report to exceptions noted for specific 
customers. 

Trading Partner Range  

Enter a range of trading partners to limit the report to exceptions noted for specific 
trading partners. 

External Trading Partner Location  

Enter the trading partner location to limit the report to exceptions noted for a 
specific trading partner location. 

External Customer Item Range  

Enter a range of customer items to limit the report to exceptions noted for specific 
customer items. 
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Release Management Exceptions Report
Inventory Item Range  

Enter a range of inventory items to limit the report to exceptions noted for specific 
items. 

Order Number Range  

Enter a range of order numbers to limit the report to exceptions noted for specific 
order numbers. 

Order Type Range  

Enter a range of active order types to limit the report to exceptions noted for specific 
order types.

Schedule Number Range  

Enter a range of schedule numbers to limit the report to exceptions noted for 
specific schedules. 

Message Category Range  

Enter a range of exception message categories to limit the report to specific message 
categories. Leave this field blank to include all message categories in the report. 

Exception Severity  

Enter exception severity to limit the report to a minimum level of exception severity. 
Exception severity may be reported at an error, warning, or information level:

■ Error

The report will include fatal errors only. Warnings and informational messages 
will not print.

■ Warning

The report will include fatal errors and warnings, but informational messages 
will not print. This is the default.

■ Information

The report will include fatal errors, warnings, and informational messages.
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Release Management Retro Billing Report
Print Details  

Enter Yes to display the report with detailed information including incoming 
schedule and matching sales order lines. Enter No for a simple view of the report.

Creation Date Range  

Enter a range of dates to limit the report to exceptions generated on a specific date. 

Sort by  

Choose from a list of criteria to sort the report using a specific parameter value.

Release Management Retro Billing Report
The Release Management Retro Billing Report identifies adjustments to already 
invoiced items. This report allows you to generate a list of invoices that may be 
eligible for retroactive billing. Based on old price versus new price, this report 
identifies the variance and possible associated adjustments. After invoicing, you 
must manually adjust the customer’s account balance to reflect the price change, 
and you may need to notify the customer via credit or debit memos.

Submission

◗◗ To run the Retro Billing Report:
1. Through Reports on the menu, navigate to the Submit Requests window.

2. Select Single Request.

3. Select Retro Billing Report from the available list of values.

4. Enter required and optional parameters.

5. Choose Submit to submit the process.

Parameters

Customer  

Select the customer to restrict the report to specific customers.

Address  

Select the customer address to restrict the report to a specific customer location.
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EDI Inbound Transactions
Invoice Number Range  

Select the range of invoice numbers to restrict the report to a range of invoices.

Invoice Date Range  

Select the range of invoice dates to restrict the report to specific invoices on specific 
dates.

Title  

Define the title that will be printed on the report. The default is Release 
Management Retro Billing Report.

Item Range  

Select the range of items to restrict the report to specific items.

Order By  

Select the method in which you want the report sorted. Select Invoice Date to sort 
the information in the report by invoice date. Select Invoice No to sort the 
information by invoice number.

EDI Inbound Transactions
The EDI Inbound Transactions concurrent program allows you to process an EDI 
transaction and load Release Management interface tables manually.

Submission

◗◗ To run EDI Inbound Transactions:
1. Through Process Inbound Transactions on the menu, navigate to the Submit 

Requests window.

2. Select Single Request.

3. Select EDI Inbound Transactions from the available list of values.

4. Enter required and optional parameters.

5. Choose Submit to submit the process.
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EDI Inbound Transactions
Parameters

Inbound File Path  

Enter the location of the inbound flat file. The default value is the current value set 
for the profile option ECE: Input File Path.

Inbound File Name  

Enter the name of the inbound transaction.

Execute DSP Flag?  

Enter Yes to execute the Demand Processor. Enter No to bypass immediate 
execution of the Demand Processor. The default is No.

Transaction Type  

Select the transaction type from the list of values for this inbound transaction. The 
default is SPSI.

Map Code  

Select the map code, as defined in the e-Commerce Gateway, from the list of values.

Debug Mode?  

Select the level of detail for the debug mode. The default value is 0.
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Release Management Demand Processor
Oracle Release Management’s processing engine, the Demand Processor is an 
Oracle Open Interface which provides complete defaulting, derivation, and 
validation for inbound demand schedules regardless of their source. The Demand 
Processor can process customer demand schedules from diverse sources including: 

■ EDI planning, shipping, and production sequence schedules processed through 
the Oracle e-Commerce Gateway

■ Manually entered schedules via Oracle Release Management Workbench

■ External system schedules loaded into the Demand Processor Interface via a 
custom process

The Demand Processor performs the following procedures:

■ Defaulting, Derivation, and Validation of schedule 

■ Archive validated schedule

■ Manage New Demand: CUM discrepancy check, cumulative to discrete 
demand quantity conversion, application of Supply Chain Sourcing Rules, 
application of delivery pattern rule and lead time offset to calculate 
ship/delivery dates, application of frozen, firm and forecast fences, aggregation 
of demand, and rounding to standard pack quantity using the Processing Rules 
in effect for a particular ship-from, customer, ship-to, or customer item.

■ Reconcile Old/New Demand: cancellation of old demand 
not-authorized-to-ship before Horizon start date, processing appropriate for 
schedule purpose code, getting eligible and matching existing demand, 
performing reconciliation of customer and supplier shipments, reconciliation of 
Past Due firm demand, reconciliation of Restricted demand, matching of 
old/new demand, and updating the sales order or forecast

The Demand Processor generates appropriate warning and error exceptions and 
informational messages during each of these procedures.
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Release Management Demand Processor
Prerequisites
To ensure that the Demand Processor works effectively, you should prepare Oracle 
Order Management and Oracle Release Management for any new customer 
demand data you want to import, including customers, pricing agreements, items, 
shipment and delivery rules, and CUM Management.

Before using the Demand Processor, you should:

■ Define Customer. See: Oracle Receivables.

■ Define Customer Addresses. See: Oracle Receivables.

■ Define Customer Receiving Calendar. See: Oracle Shipping Execution.

■ Define Warehouse Shipping Calendar. See: Oracle Shipping Execution.

■ Set up shipment delivery rules. See: Overview of Shipment Delivery Rules.

You should perform the following tasks for each customer sending demand 
transactions:

■ Define transportation lead times between your site and the customer 
destination. See: Release Management Processing Rules.

■ Verify the system defined ship delivery pattern rules.

■ Add your own ship delivery pattern rules.

■ Determine default ship delivery pattern rule for a customer destination.

■ Associate a default ship delivery pattern rule to a customer destination.

■ Associate a default ship delivery pattern rule to a customer item.

■ Define Release Management Processing Rules

Using the Release Management Processing Rules form, set up relationships 
between the ship-from organizations, customers, and addresses, defining 
attributes which are dependent on this relationship and used in the Oracle 
Release Management Demand Processor. See: Overview of Processing Rules.

■ Set up ship-from customer items terms for Release Management using the 
Release Management Processing Rules form. 

Define ship-from/ship-to relationships for each customer item using the 
Processing Rules form. For each ship-from organization effective for the 
customer item, identify the sales order to which all demand for the customer 
item should be loaded. Optionally define the standard pack quantity and 
rounding rule and the intransit lead time. See: Overview of Processing Rules.
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■ Set Up Supply Chain Sourcing Rules

You can define the schedule sourcing and splitting rules using the Supply Chain 
Sourcing Rules form if: 

■ the customer demand schedule specifies an incorrect ship-from 
organization for the customer item

Define a new sourcing rule for the schedule’s ship-from organization or the 
default warehouse associated with the customer ship-to site, with shipping 
organization type of “Make At” and allocation percentages for the desired 
ship-from organization(s). Then, create an assignment set for the sourcing rule, 
and assign the sourcing rule to the ship-to customer and site, and to the most 
preferred inventory item for the customer item specified on the customer 
demand schedule. See: Oracle Supply Chain Planning.
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Workflow Enabled
Oracle Release Management is workflow enabled in Release 11i. By setting the 
RLM: Workflow Enabled profile option, you can run the Demand Processor with 
or without the workflow option.

Submission

◗◗ To run the Release Management Demand Processor:
1. Through Demand Transactions on the menu, navigate to the Submit Requests 

window.

2. Select Single Request.

3. Select Release Management Demand Processor from the available list of values.

4. Enter required and optional parameters.

5. Choose Submit to submit the process.

Parameters

Schedule Purpose Code  

Choose a code from the list of valid purpose codes to limit processing to demand 
schedules of a specific purpose code type.

Date Range  

Enter a range of dates to limit processing to demand schedules with a Generation 
Date.

Trading Partner Range  

Enter the customer code to limit processing to demand schedules for a particular 
customer.

Ship-To Address Range  

Enter the shipping address to limit processing to demand schedules for a specific 
shipping address.

Schedule Number  

Enter the schedule number to limit processing to demand schedules
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CUM Transactions CUM Key Adjustment
Use Adjust CUM Transactions CUM Key ID concurrent program to:

■ change the CUM key identifier on previously shipped Release Management 
Order Lines if the customer has reset the CUM by back dating the current 
cumulative start date;

■ assign a Cum Key ID in the case of a new installation of Oracle Release 
Management on an existing installation of Oracle Order Management, where 
shipped sales order lines exist; 

■ assign a CUM Key ID if the customer turns on CUM management after Oracle 
Release Management has been in use for that customer. 

This applies to the CUM key ID on the shipment transactions and on the CUM 
adjustment transactions that have occurred since the start of the new CUM rule.

The following values of CUM Org Level determine which sales order lines will be 
selected and updated in this program:

■ Bill-To/Ship-From

Select sales order lines associated with the specified shipping location and the 
corresponding billing location and shipping organization.

■ Ship-To/Ship-From

Select sales order lines associated with the specified shipping location and 
shipping organization.

■ Intermediate Ship-To/Ship-From

Select sales order lines associated with the specified intermediate shipping 
location and shipping organization.

■ Ship-To/All Ship-Froms

Select sales order lines associated with the specified shipping location without 
regard to shipping organization.

This program is applicable only to the following CUM management types:

■ by date only

■ by date and record year

■ CUM until manual reset at item

■ by date and purchase order
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CUM Transactions CUM Key Adjustment
Prerequisites
Before using the Adjust CUM Transactions CUM Key ID program, you should:

1. Set Up CUM Management.

Define the CUM Rule for each customer destination and establish each 
customer item’s initial CUM quantity value based on the CUM Rule defined.

■ Use the processing rules form to set up the CUM Management Rule for 
each customer destination sending demand transactions.

2. Set Up Customer Items for Release Management.

Define ship-from/ship-to relationships for each customer item using the 
Processing Rules form. For each shipping organization effective for the 
customer item, identify the sales order to which all demand for the customer 
item should be loaded. Optionally define standard pack quantity and rounding 
rule, and the lead time for shipment date calculations.

3. Have Sales Order Shipments of Release Management Demand.

An order line must have a matching value for each applicable component of the 
CUM Key in order to be processed in Adjust CUM Transactions CUM Key ID 
program.

4. Create a Cum Key. See: Cum Key Details.

Submission

◗◗ To run the CUM Transactions CUM Key Adjustment:
1. Through CUM Key Adjustment on the menu, navigate to the Submit Requests 

window.

2. Select Single Request.

3. Select Cum Transactions Cum Key Adjustment from the available list of values.

4. Enter required and optional parameters.

5. Choose Submit to submit the process.
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Parameters
Adjust CUM Transactions CUM Key ID program has the following parameters in 
the Parameters field of the Run Concurrent Programs form:

Ship-From Organization  

Enter the shipping organization to whom the shipment transaction CUM identifier 
adjustment applies. You can choose from any inventory organization which has 
been defined as a ship-from business entity for the customer in Oracle Release 
Management.

Customer Name  

Enter the customer to whom the shipment transaction CUM identifier adjustment 
applies.

Ship-To Organization  

Enter the shipping address of the customer to whom the CUM identifier adjustment 
applies. You can choose from any address for the customer which is currently 
assigned a ship-to business purpose.

Intermediate Ship-To Organization  

If the CUM organization level for this ship-from/ship-to business entity is 
intermediate ship-to, enter the intermediate shipping location of the customer to 
whom the CUM identifier adjustment applies. You can choose from any address for 
the customer which is currently assigned a ship-to business purpose.

Bill-To Location  

If the CUM organization level for this ship-from/ship-to business entity is 
bill-to/ship-from, enter the billing address of the customer to whom the CUM 
identifier adjustment applies. You can choose from any customer address currently 
assigned a bill-to business purpose. This field defaults to the billing address 
associated with the specified shipping address.

Customer Item  

Select a customer item for which you want to adjust the CUM Key from the list of 
values. If nothing is selected here, all the customer items for the above selected 
criteria will be adjusted.
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Transaction Start Date  

Enter the shipment transaction start date. Shipment transactions within the range 
you specify will be eligible for CUM identifier adjustment if they are associated 
with the eligible CUM key components. This date must be less than the shipment 
transaction end date. 

Transaction End Date  

Enter the shipment transaction end date. Shipment transactions within the range 
you specify will be eligible for CUM identifier adjustment if they are associated 
with the eligible CUM key components. This date must be greater than the 
shipment transaction start date. The default is the current system date.

See Also
Release Management Processing Rules
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Windows and Navigator Paths

Windows and Navigator Paths
This appendix shows the default navigator path for each Oracle Release 
Management window. Refer to this appendix when you do not already know the 
path for windows you want to use.

Text in brackets [ ] indicates a button.

Window Navigator Menu Path

Create CUM Keys Release Management > CUM Workbench > [CUM Key] > [Create CUM Keys]

CUM Key Details Release Management > CUM Workbench > [CUM Key]

CUM Workbench Release Management > CUM Workbench

Enter CUM Adjustment Release Management > CUM Workbench > [CUM Key] > [Enter Adjustments]

Find CUM Details Release Management > CUM Workbench

Find Processing Rules Release Management > Setup > Processing Rules

Horizontal Demand Release Management > Release Management Workbench > Schedule Summary > 
[Lines] > Schedule Details - Lines View > [Horizontal Demand]

Horizontal Schedule Release Management > Release Management Workbench > Schedule Summary > 
[Lines] > Schedule Details - Lines View > [Horizontal Schedule]

Line Addresses Details Release Management > Release Management Workbench > Schedule Summary > 
[Lines] > Schedule Details - Lines View > [Addresses]

Maintain Ship/Delivery 
Pattern Codes

Release Management > Release Management > Setup > Shipment Delivery Rules

Matching Attributes Release Management > Setup > Processing Rules > Release Management Processing 
Rules > [Matching Logic]
aths A-1



Windows and Navigator Paths
Processing Rules At 
Address Item Level

Release Management > Setup > Processing Rules > Release Management Processing 
Rules > [Item Rules]

Processing Rules At 
Address Level

Release Management > Setup > Processing Rules > Release Management Processing 
Rules > [Address Rules]

Processing Rules At 
Customer Item Level

Release Management > Setup > Processing Rules > Release Management Processing 
Rules > [Item Rules]

Processing Rules At 
Customer Level

Release Management > Setup > Processing Rules > Release Management Processing 
Rules > [Customer Rules]

Release Management 
Processing Rules

Release Management > Setup > Processing Rules

Release Management 
Workbench

Release Management > Release Management Workbench

Schedule Details - 
Exceptions View

Release Management > Release Management Workbench > Schedule Summary > 
[Exceptions] > Schedule Details - Exceptions View

Schedule Details - 
Header View

Release Management > Release Management Workbench > Schedule Summary > 
[Header] > Schedule Details - Header View

Schedule Details - Lines 
View

Release Management > Release Management Workbench > Schedule Summary > 
[Lines] > Schedule Details - Lines View

Schedule Summary Release Management > Release Management Workbench > Schedule Summary

Window Navigator Menu Path
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Release Management Profile Options

Overview of Profile Options
During Implementation, you set a value for each user profile option to specify how 
Oracle Release Management controls access to and processes data.

Generally, your system administrator sets up and updates profile option values. 
The Oracle Applications System Administration User’s Guide contains more 
information on profile options, including the internal names of each Release 
Management profile option. The following information is included here for your 
convenience.

Profile Option Settings
You can set or view the following profile options in Oracle Release Management. 
The table also includes profile options from other applications that are used by 
Oracle Release Management. This table indicates whether you (the “User”) can 
view or update the profile option and at which System Administrator levels the 
profile options can be updated: User, Responsibility, Application, or Site levels.

A “Required” profile option requires you to provide a value. An “Optional” profile 
option provides a default value which you may change if you do not want to accept 
this default.
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Overview of Profile Options
The following profile options affect the operation of the Demand Processor:

RLM: MRP Forecast Selection List
Provides a means to specify the forecast source list that will house all the names of 
Forecasts that are candidates for the inbound Automotive forecast demand items to 
be assigned.

The default value is “none”.

This profile can be set at the Site level.

Profile Option User System Administrator Requirements

User User Resp App Site Required? Default Value

RLM: MRP Forecast Selection List 0 0 0 0 X No No Default

RLM: Print CUM Data on 
Shipping Documents

X X X X X No Yes

RLM: Debug Mode X X X X X No NULL

RLM: CUM Management Enabled 0 0 0 0 X No Yes

RLM: Workflow Enabled X X X X X No No

ECE: SPSI-Enabled 0 0 X 0 X Yes No Default

ECE: SSSI-Enabled 0 0 X 0 X Yes No Default

ECE: PSQI Enabled 0 0 X 0 X Yes No Default

ECE: Input File Path - - X - X Yes No Default

ECE: Output File Path - - X - X Yes No Default

ECE: DSNO-Enabled 0 0 X 0 X No No Default

ECE: INO-Enabled - 0 X 0 X No No Default

WSH: Invoice Numbering 
Method

X X X X X Yes Automatic

Key:

X You can update the profile option value.

- You can view the profile option value but you cannot change it.

0 You cannot view or change the profile option value.
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Overview of Profile Options
RLM: CUM Management Enabled
Determines whether or not CUM Management is enabled at the Site level. To use 
the CUM Management features of Oracle Release Management, this must be set to 
Yes. Available values are:

Yes - CUM Management is enabled for this site.

No - CUM Management is disabled for this site.

The default is Yes.

This profile is updatable only at the Site level.

RLM: Print CUM Data on Shipping Documents
Determines whether or not CUM Data should be printed on shipping documents. 
Available values are:

Yes - CUM Data is printed on shipping documents.

No - CUM Data is excluded from shipping documents.

The default is Yes.

This profile is updatable at all levels.

RLM: Debug Mode
Determines if debug file is written for running the Demand Processor. Available 
values are:

0 - highest debug level

Null - no debug

The default value is Null.

This profile is updatable at all levels.

Note: This profile option is required if you import forecast data 
into Oracle Planning using the Demand Time Fence Forecast to 
Planning. See Processing Rules for more information.
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Overview of Profile Options
RLM: Workflow Enabled
Determines whether or not the Demand Processor is enabled to run in workflow 
mode. Available values are:

Yes - The Demand Processor is enabled to run in workflow mode.

No - The Demand Processor is disabled for workflow mode.

The default is No.

This profile is updatable at all levels.

ECE: SPSI Enabled
Determines whether or not inbound planning schedule transaction is enabled.

There is no default value.

This profile can only be set at the site and responsibility levels.

ECE: SSSI Enabled
Determines whether or not inbound shipping schedule transaction is enabled.

There is no default value.

This profile can only be set at the site and responsibility levels.

ECE: PSQI Enabled
Determines whether or not inbound sequenced shipping schedule transaction is 
enabled.

There is no default value.

This profile can only be set at the site and responsibility levels.

ECE: Input File Path
Specifies the directory where inbound data files are expected. This value must 
match the actual directory on disk and that designated in the INIT.ORA file.

There is no default value.

This profile can only be set at the site and responsibility levels.
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Overview of Profile Options
ECE: Output File Path
Specifies the directory where outbound interface data files are written. This value 
must match the actual directory on disk and that designated in the INIT.ORA file.

There is no default value.

This profile can only be set at the site and responsibility levels.

ECE: DSNO Enabled
Specifies whether or not the DSNO transaction is enabled.

There is no default value.

This profile can only be set at the site and responsibility levels.

ECE: INO Enabled
Specifies whether or not the INO transaction is enabled at the site level. 

There is no default value.

This profile can only be set at the site and responsibility levels.

WSH: Invoice Numbering Method
Determines whether invoice numbers are automatically generated or are, instead, 
mapped to the delivery name. Available values are:

Delivery Name - The delivery name is used as the invoice number.

Automatic - Autoinvoice, automatically creates the invoice number. 

The default is Automatic.

Note: For the e-Commerce Gateway, you must create inbound 
and outbound directories on your server, and then specify them in 
the INIT.ORA file and in the “ECE: Inbound File Path” and “ECE: 
Outbound File Path” profile options, respectively. See: Defining 
Data File Directories, Oracle e-Commerce Gateway Implementation 
Manual, Release 11i.
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Glossary

A

ABR

Attribute Based Release system. This is an alternate acronym for FBO or FBR used 
by Navistar.

Advanced Ship Notice (ASN)

An electronic document that notifies the customer of a supplier shipment and its 
contents. This document can include a list of shipment contents, order information, 
product description, physical characteristics, type of packaging, marking carrier 
information and configuration of the goods within the transportation equipment. 

The ASC X12 transaction name for this EDI document is the 856. The EDIFACT 
message name for this EDI document is DESADV. Also referred to as Ship 
Notice/Manifest.

ahead

Quantities were delivered in advance of the customer’s anticipated delivery date, or 
an over shipment in quantities occurred. The supplier must control this situation in 
such a way that he will not manufacture or deliver these quantities again. See: 
Behind.

AIAG

Automotive Industry Action Group, an organization which publishes combined 
EDI implementation requirements for the major automotive industry manufacturers 
and suppliers.
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ANSI   

American National Standards Institute which establishes national standards for the 
United States. The parent organization for X12 and also serves as the North 
American representative to ISO (International Standards Organization).

ANX

Automotive Network Exchange. A common, global TCP/IP network infrastructure 
created to meet the data communications needs of the automotive industry. Using 
ANX, each automotive supplier and OEM needs only a single commercial-grade 
TCP/IP data transport connection to communicate globally with all trading 
partners. This network meets specific automotive industry requirements for 
performance, reliability, security and management. 

archival

The saving of transaction data. There are different types of archival relating to EDI 
transactions; this document uses the second meaning when referring to archival: 

1) Legal Archival: setting aside a copy of the actual EDI transaction in its legal state 
immediately before (for outbound) or after (for inbound) electronic transmission, 
prior to any manipulation or interpretation of data by the EDI translator or 
application software

2) Oracle Application Archival: setting aside a copy of data contained in the EDI 
transaction loaded into the Release Management Archived Schedule tables after 
defaulting, derivation, and validation processing in the Release Management 
Demand Processor Open Interface, but before applying delivery date and quantity 
calculation rules and netting procedures.

ASC

Accredited Standards Committee X12 group. Accredited by ANSI, this group 
maintains and develops EDI standards for the United States and Canada.

ATS

Authorized To Ship. This term applies to sales order lines eligible to enter the 
workflow processes which ultimately result in shipment of the product to the 
customer (such as production, departure planning, picking, and ship/confirm). It 
distinguishes them from sales order lines which are not eligible for any 
shipment-related processing.
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Automotive Address Extras

Used in Release 11 of Oracle Automotive. The Automotive Address Extras 
represented ship-from/ship-to data that was established in Oracle Automotive, and 
exported to Radley CARaS. 

Automotive address extras is not used in Release 11i. Instead, the ship-from/ship-to 
terms window is used to store information critical to Oracle Release Management.

B

balancing out 

The process of monitoring and balancing production of a scheduled item as it 
moves into a later phase in its life cycle. The item’s planned change in status may be 
known up to a year in advance, and is closely monitored during the last few months 
of the model year by both the customer and supplier.

behind

Quantities were not delivered in time (past due) in context of the customer’s 
anticipated delivery date, or an under shipment occurred. The supplier must 
control this situation in such a way that he will deliver these quantities as soon as 
possible. See: ahead.

best discount   

The most advantageous discount for the customer. For example, suppose you have 
a customer discount of 15% and a item discount of 25% for Product B. If you enter 
an order line for the customer for Product A, the line is discounted 15%. If you enter 
an order line for the customer for product B, the line is discounted 25%. 

bill of lading   

A carrier’s contract and receipt of goods transported from one location to another.

bill-to address   

The customer’s billing address. It is also known as invoice-to address. It is used as a 
level of detail when defining a forecast. If a forecast has a bill-to address associated 
with it, a sales order only consumes that forecast if the bill-to address is the same.

bucket days 

The number of workdays within a repetitive planning period.
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bucket type - daily 

Bucket based on a single calendar day.

bucket type - flexible

When the customer specifies the start date and end date of the bucket, instead of 
using standard bucket types of daily, weekly, monthly or quarterly.

bucket type - monthly

Bucket based on a calendar month.

bucket type - quarterly

Bucket based on calendar quarters (Jan - Mar, Apr - Jun, Jul - Sep, Oct - Dec.)

bucket type - weekly

Bucket based on a weekly interval, usually Monday through Sunday.

C

container   

The receptacle (box, tank, etc.) in which items to be shipped are placed.

Critical Attributes

Optional Matching Attributes should always have a value as turnaround data, 
regardless of what schedule type is associated with the demand. If this flag is on 
and the attribute does not have a value, the Demand Processor will issue a warning 
exception identifying it.

CUM entity 

The identifier of the customer’s business entity applicable for CUM Management 
when the supplier ships to a particular customer location. This may be the Ship To 
Location, Deliver To Location or Bill To Location, depending on the CUM Entity 
Type assigned to the Ship To/Ship From Terms relationship.

CUM entity type

The customer’s business entity type applicable for CUM Management when the 
supplier ships to a particular customer location. The valid CUM Entity Types are: 
Ship To/Ship From, Bill To/Ship From, Deliver To/Ship From, Ship To/All Ship 
Froms, Bill To/All Ship Froms, Deliver To/All Ship Froms.
Glossary-4                                                                         



CUM key

The set of attribute values applicable to accumulation of shipments and CUM 
adjustments of a Customer Item in a Ship To / Ship From relationship. The 
applicable attributes are determined by the CUM Management Type and CUM 
Entity selected for the Ship To / Ship From relationship; the applicable values are 
captured at the time the CUM Key is created.

CUM management type

The style of CUM Management applicable to a customer/supplier relationship. One 
of six styles of CUM Management may be associated with a customer/supplier 
relationship: No CUM Management, CUM By Date, CUM By Date/Record Year, 
CUM By Date/PO, CUM By Purchase Order, CUM Until Manual Reset at Item.

CUM period 

A defined period of time during which cumulative shipment, requirement, and 
resource authorization quantities are calculated, e.g. Record keeping year, Calendar 
Year, or life of Purchase Order. In the automotive industry, the CUM Period 
typically coincides with a customer’s scheduled plant shutdown for record keeping 
year tooling changeovers. All ship-from locations to the same customer destination 
will share the same CUM Period.

CUM Rule

The definition of how the CUM is to be calculated for Customer Items under 
Release Management within a specific Ship To/Ship From relationship. The rule 
consists of the following components: CUM Management Type, CUM Entity, CUM 
Start Date, Shipment Inclusion Rule.

cumulative received quantity

The total quantity of goods (e.g. shipped or received) during a defined period of 
time, e.g. Model Year. This can be used by suppliers to represent year-to-date 
shipped and by trading partners as year-to-date received.

customer control number

AIAG term for an external customer’s order number for a finished good, e.g. a 
vehicle, apart from job numbers assigned in the production process.

customer item

Allows you to define specific attributes for items per customer class, customer and 
ship-to/bill-to location. Demand Tolerance is an example for such an attribute.
                                                            Glossary-5



customer job number

The number customers assign to jobs on their production line. These numbers are 
arbitrarily assigned and not sequential.

customer line number Vs. supplier line number 

The term ‘customer line number’ represents the line sequence number as defined in 
the Purchasing application. Once this number or code is assigned to a line in the 
Purchase Order, it should not be changed. The general term ‘supplier line number’ or 
Oracle Order Management’s ‘order line number’ represents the line sequence 
number as defined in the Order Management application. Once this number or code 
is assigned to a line in the sales order, it should not be changed.

customer model serial number

In the Automotive industry, this is the Vehicle Identification Number (VIN).

customer production line number

The identifier for the customer’s production line, i.e. the line on which they are 
building the product. This can affect the delivery and departure if, for example, the 
customer wants all items for production line A123 to be on the same delivery.

customer production sequence number 

A customer (trading partner) may have a particular sequence in which items are 
built into an assembly. For example, the customer may specify that the front axle of 
a car has a production sequence 45 assigned to it, while the production sequence of 
the rear axle is 46. see loading order sequence, planning production sequence 
number.

Customs Invoice

An electronic or paper document for international shipments similar to a Ship 
Notice/Manifest, but including additional information to satisfy all customs 
requirements of the borders through which the shipment must pass, such as the 
value of the shipment, VAT code and amounts, tariff and duty information, port 
information, customs broker identification, exporter identification, import license 
information, and letter of credit information.

D

delivery 

A set of order lines to be shipped to a customer’s ship-to location on a given date in 
a given vehicle. Multiple deliveries can be grouped into a single departure. A single 
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delivery may include items from different sales orders and may include backorders 
as well as regular orders. 

delivery assignment

Defines the relationship of deliveries and child deliveries through consolidations as 
well as the relationship between delivery details and itself to track containerization 
of items. 

delivery date

The date on which the product is to arrive at the Ship-To Location. This date is 
either specified by the customer on a delivery-based demand transaction, or 
calculated by applying in-transit lead time to a customer-specified Shipment Date.

delivery detail

Contains items to be shipped out of a warehouse. This may be a sales order line, an 
RMA line, a WIP line or a PO line. They can be referred to as deliverables. 

Delivery Instruction (DELINS) 

The Delivery Instruction Message is sent by a buyer to provide information 
regarding details for both short term delivery instructions and 
medium-to-long-term requirements for planning purposes according to conditions 
set out in a contract or order.

delivery lead time 

Time (in days) is takes for items to reach the customer once it is shipped. It accounts 
for any non-working days in between. 

delivery leg

A single segment of a delivery. Every delivery consists of at least two legs, when the 
delivery is picked up and dropped off, but may travel through several intermediate 
legs.

delivery line 

A shippable and booked line from the planning pool which has been allocated to a 
delivery. After allocation, the line is no longer available in the planning pool. After 
the delivery is closed, the delivery line will also be considered closed.

Delivery Shipping Notice Outbound (DSNO)

An Advanced Ship Notice generated by Oracle e-Commerce Gateway for a shipped 
delivery.
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demand 

Current or future product need communicated by the customer to the supplier, via 
EDI or other means. Sources of demand include Purchase Orders, Planning 
Schedules, Shipping Schedules, and Sequenced Production schedules.

Demand Processor

The Oracle Release Management program that resolves items from an Oracle open 
interface demand schedule file, validates demand data against Oracle Applications 
information, then passes the demand into Oracle Order Management to create or 
replace sales order lines or into Oracle Planning (Oracle Master Scheduling/MRP 
and Oracle Supply Chain Planning) to create or replace forecasts. 

demand schedule

A planning, shipping, or sequenced production schedule received by a supplier 
from a customer, usually in an EDI file format.

destination-street   

The destination street name and number are very important. The consignee is 
extremely difficult to locate without the exact and proper street address to which 
the shipment is to be delivered. Therefore to avoid additional delivery charges and 
possible delays, it is imperative that this information be furnished.

destination-zip   

The zip is required to determine the exact location of the shipping point. Zip codes 
are the basis for many carriers freight charges.presented to the user as a workbench. 

detail container 

Inner container that is enclosed within the master container. See master container.

DSNO

Transaction code assigned to outbound electronic Departure Based Ship 
Notice/Manifest transaction in the Oracle E-Commerce Gateway, based on 
information processed through the Oracle Departure Planning application. 

E

EDI 

See Electronic Data Interchange (EDI).
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Electronic Data Interchange (EDI) 

Exchanging business documents electronically between trading partners. EDI 
subscribes to standard formats for conducting these electronic transactions as stated 
by various standards.

Evaluated Receipts Settlement (ERS) 

A Payment on Receipt system, a process whereby Trading Partners generate 
payment obligation transactions in their accounts payable system upon receipt of a 
shipment of goods, eliminating the need for invoices or invoice transactions. This 
system combines information from the electronic Advance Shipment Notice (ASN), 
the receipt, and the purchase order. It ensures accurate and timely data processing. 
Also known as Self Billing.

export paper

A document required by governmental agencies that provides information on 
goods shipped out of or into a country.

export licenses 

A government license to supply certain products to certain countries that would 
otherwise be restricted.

extended line amount 

Oracle Order Management prints the extended order line amount for each order 
line.

extended price 

The extended price is the cost of the line. This is computed by multiplying the 
selling price per unit by the number of units ordered on that line. Thus, if two of 
item A cost $10.00 each, the extended price is $20.00 for the line.

extensible order contacts model 

How will we specify contacts for the order for any purpose relevant to your 
business.

external forecast

This is the forecast that is created based on the customers transmitted “forecasted” 
demand for a specific time horizon. The transmission of this forecast is 
predominantly via EDI. In Release Management any forecast information that is 
interfaced to MRP by the Demand Processor is considered external forecast.
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external system

Any application outside of the Oracle environment.

F

FAS

Final Assembly Schedule. A discrete job created from a custom configuration or a 
standard configure-to-order item and linked to a sales order.

FBO

Feature Based Ordering (FBO), also known as Feature Based Releasing (FBR) and 
Attribute Based Releasing (ABR), is a business process of ordering and releasing 
product by specifying a feature or group of features rather than the traditional 
upper level identifier or item number. 

FBR

Feature Based Releasing. This is an alternate acronym for FBO or ABR, used by 
Ford and others.

firm demand

Inbound demand that Oracle Release Management passes as Authorized To Ship 
(ATS) to a sales order in Oracle Order Management.

firm fence

An optional Release Management setup feature which defines a range of days either 
from the beginning of the demand schedule horizon or following the optional 
frozen fence. The firm fence instructs the Demand Processor to override the 
demand status on the schedule with a Firm status when updating the sales order 
lines.

forecast demand

A part of your total demand that comes from forecasts, not actual sales orders.

forecast fence (OM)

An optional Release Management setup feature which defines a range of days from 
the beginning of the demand schedule horizon or following the optional Frozen and 
firm fences. The Forecast Fence instructs the Demand Processor to override the 
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demand status on the schedule with a Forecast status when updating the sales order 
lines. 

forecast fence (MRP)

An optional Release Management setup feature which defines a range of days from 
the beginning of the demand schedule horizon or following the optional Frozen, 
Firm, and OM Forecast Fences. The MRP Forecast Fence instructs the Demand 
Processor to override the demand status on the schedule with a Forecast status and 
update MRP Planning rather than the sales order. When the demand is scheduled to 
be shipped later than the ending day of MRP Forecast Fence, the demand is not 
updated to MRP Planning. 

frozen

Term to describe the independence of the Archive data from the standing data. 

frozen fence

An optional Release Management setup feature which defines a range of days from 
the beginning of the demand schedule horizon. The frozen fence instructs the 
Demand Processor to leave existing sales order demand intact if the schedule 
indicates changes to demand within this time.

fulfilled quantity

In the Order Management schema, the accepted quantity was the number of items 
received from the customer on a given line that are approved to issue credit for. In 
Order Management, the accepted quantity is referred to as the fulfilled quantity. 

fulfillment

Fulfilled sales order lines have successfully completed all Workflow processing 
activities up to the point of becoming eligible for invoicing. 

fulfillment method 

Fulfillment method is an activity which will be considered as a prerequisite before a 
line or a group of lines can be fulfilled. The fulfillment method must be associated 
with one and only one work flow activity. In this document fulfillment method and 
fulfillment activity have been used in the same context. If no fulfillment activity has 
been set in a flow for a line which is not part of any fulfillment set or PTO/KIT, the 
line will not wait at the fulfillment.
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fulfillment set 

Items in a fulfillment set will be available for scheduling and shipping only when 
all the items are available and ready to be scheduled/shipped. Fulfillment sets can 
be complete only, or partially allowed but in proportions. ATO model, and a PTO 
Ship model Complete will be in a fulfillment set.

G

gross weight 

The weight of the fully loaded vehicle, container, or item, including packed items 
and packaging material.

H

hierarchical levels

The nesting of information within an electronic Ship Notice/Manifest. Each 
hierarchical level is identified with its own unique sequence number and, if nested, 
the sequence number of its parent hierarchical level.

hierarchical structure

Defines the actual layout of different hierarchical levels indicating the nesting of 
information in an electronic Ship Notice/Manifest transaction.

hold

A feature that prevents an order or order line from progressing through the order 
cycle. You can place a hold on any order or order line.

I

Industry Attributes

Elements specific to an individual industry. An example of an industry attribute for 
the automotive industry would be the model year.

INO

Transaction code assigned to outbound electronic Invoice transaction in the Oracle 
E-Commerce Gateway, based on information processed through the Oracle 
AutoInvoice application. 
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internal forecast

The forecast information created by the planners. It differs from the external 
forecast which is fed into MRP by transmissions from the customer.

Item/Entity Relationship

The collection of key attributes defined by the customer which cause Planning or 
Shipping Schedule details to be processed together as a group. If the customer 
manages CUMs, it is usually the collection of key attributes on which the 
cumulative quantity is based. An Item/Entity consists of a unique combination of: 
Customer Item Number, Address entities deemed relevant to the customer, Other 
customer-specific identifiers which separate items on a schedule, such as Purchase 
Order, Record-Keeping Year, or Item Revision.

K

kanban

A method of Just-in-Time production that uses standard containers or lot sizes with 
a single card attached to each. It is a pull system in which work centers signal with a 
card that they wish  to withdraw parts from feeding operations or suppliers. The 
Japanese word kanban, loosely translated, means card, billboard, or sign. The term is 
often used synonymously for the specific scheduling system developed and used by 
the Toyota Corporation in Japan.

KANBAN Signal Message (KANBAN) 

The KANBAN Signal ODETTE Message is an electronic transaction issued by a 
consignee giving authorization to the consignor to ship material based upon 
receiving a Kanban signal and following the principles of the Just-In-Time 
philosophy.

key attributes

A set of demand attributes which uniquely identifies the requirement, consisting of 
all mandatory matching attributes and those optional matching attributes which 
have been enabled. Demand Processor uses key attributes to determine if incoming 
demand is new or a change on previously transmitted demand. 
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L

lane 

Single Origin/Destination pairs which can be established at any level of a 
geographic hierarchy (a given address, Postal Code, City, County, State, Country, 
Zone).

load interface - Create 830 / 862 Flatfile

In Oracle Supplier Scheduling, the e-Commerce Gateway Interface tables are 
populated for confirmed planning or shipping schedules for all electronic supplier 
sites. The appropriate outbound 830 or 862 flat file is then created.

M

mandatory matching attributes

Matching Attributes always applied to demand regardless of the specific business 
entities or schedule type associated with the demand. They are always enabled 
within like schedule type and across different schedule types. 

master container 

Outer-most container in a “container within container” scenario. See: Detail 
Container.

matching attributes

Data elements used by Oracle Release Management’s Demand Processor to 
compare new demand lines on inbound demand schedules to existing demand lines 
on Sales Orders for the purpose of demand reconciliation, to prevent unwarranted 
duplication of demand. 

N

NAFTA

North American Free Trade Association.

NATS

Not Authorized To Ship. This term applies to sales order lines which are forecast 
status only, not eligible to enter any workflow processes which ultimately result in 
shipment of the product to the customer, such as production, departure planning, 
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picking, and ship/confirm. This distinguishes them from sales order lines which are 
eligible for all shipment-related processing (ATS).

net weight 

Weight of the contained load. Commonly calculated as GROSS - TARE, this includes 
the weight of any packing materials (paper, cardboard separators, Styrofoam 
peanuts, etc.). 

O

optional matching attributes

Matching Attributes which can vary based on the business needs of specific 
business entities or schedule type associated with the demand.

P

pick release

An order cycle action to notify warehouse personnel that orders are ready for 
picking.

picking line 

An instruction to pick a specific quantity of a specific item for a specific order. Each 
pick slip contains one or more picking lines, depending on the number of distinct 
items released on the pick slip. 

picking rule

A user-defined set of criteria to define the priorities Order Management uses when 
picking items out of finished goods inventory to ship to a customer. Picking rules 
are defined in Oracle Inventory.

planning schedule 

An EDI document (830/DELFOR/DELINS) used to communicate long-range 
forecast and material release information to suppliers.

production lineset

The units committed and sequenced to build in production for a specific number 
days at a customer’s manufacturing facility.
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Production Sequence Schedule (PSQI)

An EDI document (866/CALDEL/SYNCRO & SYNPAC) used to request the order 
in which shipments of goods arrive, or to specify the order in which the goods are 
to be unloaded from the conveyance method, or both. This specifies the sequence in 
which the goods are to enter the materials handling process, or are to be consumed 
in the production process, or both. Dates are always discrete, never “bucketed”.

profile option   

A set of changeable options that affect the way your applications run. In general, 
profile options can be set at one or more of the following levels: site, application, 
responsibility, and user.

Q

QS-9000

An automotive quality standard incorporating the ISO 9000 series requirements and 
those specific to the automotive industry, agreed upon by the Big Three plus five 
truck manufacturers, who joined forces to streamline their quality system 
requirements.

R

RAN Number

Release Authorization Number. This may be included in an electronic Shipping 
Schedule (862) transaction. If given, it must be referenced on the shipping 
documents, ASN, and invoice which are sent to the customer.

See Ship Reference Number.

release 

An actual order of goods and services you issue against a blanket purchase 
agreement. The blanket purchase agreement determines the characteristics and the 
prices of the items. The release specifies the actual quantities and dates ordered for 
the items. You identify a release by the combination of blanket purchase agreement 
number and release number.
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resource authorizations 

Resource Authorizations address the supplier’s need to have long lead time 
components or to invest in material processing without incurring economic 
hardship if requirements are reduced.

Retroactive Billing

A pricing system which can extend to shipped products. Pricing is based on 
customer purchase order modifications, for example, changes in commodity prices 
or expected production volume. The difference between the price originally billed 
when the product shipped and the new applicable price is calculated and applied to 
applicable shipped quantities. The customer is billed (or credited) for the 
adjustment.

route 

An ordered sequence of Lane Segments, from point of Origin to point of Ultimate 
Destination for a shipment. The sum of all of the lane segments, i.e.: where “A” to 
“B” and “B” to “C” are lane segments, the route will be “A” to “C”. 

S

schedule

A transaction containing current or future product demand, communicated by the 
customer to the supplier via EDI or other means. Types of schedules include 
Planning, Shipping, and Sequenced Production schedules.

schedule horizon

Consists of the dates enclosed by the Horizon Start Date and the Horizon End Date. 
In a customer demand schedule, demand requirements and resource authorizations 
will be dated on or within this date range. 

schedule item 

A specific Customer Item on a demand schedule associated with a specific set of 
business entities and important CUM-related qualifiers. Demand and other 
information is grouped by the customer within Schedule Item.

schedule item number

The number assigned to all demand, authorizations, shipment/receipt information, 
and other information related to the Schedule Item. This number is not applicable to 
sequences schedules.
                                                            Glossary-17



schedule purpose code

Criteria used by the Release Management Demand Processor to interpret demand 
for each item on a schedule within the horizon date range. 

scheduled ship date

The date on which the product is scheduled to depart from the Ship-From Location. 

Sequenced Delivery Message (SYNCRO)

Issued by a consignee giving authorization to the consignor to ship material in 
sequence based upon actual production requirements following the principles of 
the Just-In-Time philosophy.

ship confirm 

A process in Shipping Execution which allows you to identify shipped quantities, 
assign inventory control information for released lines, assign freight charges, and 
specify whether or not to backorder unfulfilled quantities of released line items.

Ship Delivery Pattern Code

Usually applied against a weekly quantity to describe how demand is allotted. This 
code indicates which days of the week the customer wants the quantity delivered 
and how the weekly quantity is to be divided between the different ship days.

ship-to address

A location where items are to be shipped.

shipment reference number

A unique reference number associated with a unique shipment date/time and 
quantity combination.

shipment set

A group of items that must ship-together.

shipping schedule 

An EDI document (862/DELJIT/DELINS) used by a customer to convey precise 
shipping schedule requirements to a supplier, and intended to supplement the 
planning schedule transaction set (830/DELFOR). 
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SPSI

Transaction code assigned to inbound electronic Planning Schedule with Release 
Capability transaction in the Oracle e-Commerce Gateway. Data from this 
transaction feeds into Oracle Release Management Demand Processor.

SSSI

Transaction code assigned to inbound electronic Shipping Schedule transaction in 
the Oracle e-Commerce Gateway. Data from this transaction feeds into Oracle 
Release Management Demand Processor.

supply chain sourcing rules

A set of rules that define the supplier priority rank and percentage split for the 
ship-to organization’s planning requirements or the ship-from organization’s 
demand routing.

T

TAG

Truck Advisory Group. An association of heavy truck and off-road vehicle 
manufacturers, suppliers, carriers, and value added networks.

tare weight

The weight of an item, excluding packaging or included items.

trading partner   

Any company that sends and receives documents via EDI.

transaction set   

A complete business document such as an invoice, a purchase order, or a remittance 
advice. Synonym for document or message.

transportation network 

The organized substructure which defines the path and means of transportation 
between points of origin and points of ultimate destination. Includes Routes, Lanes, 
Zones, Locations.
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trip 

An instance of a specific Freight Carrier departing from a particular location 
containing deliveries. The carrier may make other stops on its way from the starting 
point to its final destination. These stops may be for picking up or dropping off 
deliveries.

trip stop

A location at which the trip is due for a pick-up or drop-off.

trip stops

Represents a point along the route a trip makes to its final destination. This point 
may also have some activity associated with it. The activity might include picking 
up a new delivery, dropping off a delivery or both.

V

Value Added Network (VAN)

A secure and privately owned network offering services such as mailboxing, 
reliable data transmission, carbon copy services, access methods and other 
value-added capabilities.

vehicle

An exact instance of a vehicle type (for example, truck123). This information is sent 
to the customer through the Advance Ship Notice.

X

X12   

ANSI standard for inter-industry electronic interchange of business transactions.

XML

Extensible Markup Language. Used to describe information which is usually 
associated with Web based applications and documents destined for usage or access 
by or through the Internet. It is a structured way of representing data that will be 
electronically exchanged and is platform and standards independent. 
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Z

zone 

The geographic region surrounding a city, a postal code, a county, a state, a country 
to which carriers’ transportation lead time and rate for the city, postal code, county, 
state, or country also apply.
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